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English

Operating Instructions

The Signet 2551 Magmeter is an insertion-style magnetic flow sensor. The patented
sensor design is available in a variety of corrosion-resistant materials to provide long-
— . term reliability and minimal maintenance costs. Wetted material combinations include
PP/316 SS, PVDF/Hastelloy-C and PVDF/Titanium. The 2551 installs quickly and

- securely into a wide selection of flow fittings to deliver accurate flow measurement in
g’ pipe sizes ranging from DN15 to DN90O (%2 in. to 36 in.).
Signet 2551 Magmeters are available with a frequency output or Digital (S°L) output
for use with the Signet 9900-1BC Batch Controller, 8900 Multi-Parameter Controller
or 9900 Transmitter, or with a 4 to 20 mA output for a direct input to a PLC, SCADA or

telemetry system.

S All 2551 Magmeters feature empty pipe detection and LED-assisted diagnostics.
The Signet 3-0252 Configuration Tool set-up tool is available to customize every
performance feature in the 2551 to adapt it to the specific application requirements.
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Warranty Information

Refer to your local Georg Fischer Sales office for the most
current warranty statement.

All warranty and non-warranty repairs being returned must
include a fully completed Service Form and goods must be
returned to your local GF Sales office or distributor.
Product returned without a Service Form may not be
warranty replaced or repaired.

Signet products with limited shelf-life (e.g. pH, ORP, chlorine
electrodes, calibration solutions; e.g. pH buffers, turbidity
standards or other solutions) are warranted out of box but not
warranted against any damage, due to process or application
failures (e.g. high temperature, chemical poisoning, dry-out) or
mishandling (e.g. broken glass, damaged membrane, freezing
and/or extreme temperatures).

Product Registration

Thank you for purchasing the Signet line of Georg Fischer
measurement products.
If you would like to register your product(s), you can now
register online in one of the following ways:
* Visit our website www.gfsignet.com.
Under Service and Support click on
Product Registration Form
« If this is a pdf manual (digital copy), click here

Chemical Compatibility

The retaining nuts of Magmeters are not designed for
prolonged contact with aggressive substances. Strong acids,
caustic substances and solvents or their vapor may lead to
failure of the retaining nut, ejection of the sensor and loss

of the process fluid with possibly serious consequences,
such as damage to equipment and serious personal injury.
Retaining nuts that may have been in contact with such
substances, e.g. due to leakage or spilling, must be replaced.

<— 94mm —>
(3.7in.)
79.25 mm
(3.121in.)
Pipe Range: A
1/2to4in. -X0 = 58 mm (2.3 in.) X0 =>
5t08in. -X1=91mm(3.6in.) X1
10t0 36in.-X2= 167 mm (6.6in.) | v,
X = Sensor Body P, T, or V Y

Safety Information

Depressurize and vent system prior to installation or removal.
Confirm chemical compatibility before use.

Do not exceed maximum temperature/pressure specifications.
Wear safety goggles or face shield during installation/service.
Do not alter product construction.

Disconnect power before attempting any service or wiring.

Caution / Warning / Danger
Indicates a potential hazard. Failure to follow all warnings
may lead to equipment damage, injury, or death

Electrostatic Discharge (ESD) / Electrocution Danger
Alerts user to risk of potential damage to product by ESD,
and/or risk of potential of injury or death via electrocution.

Personal Protective Equipment (PPE)
Always utilize the most appropriate PPE during
installation and service of Signet products.
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Pressurized System Warning

Sensor may be under pressure, take caution to vent
system prior to installation or removal. Failure to do so
may result in equipment damage and/or serious injury.
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Hand Tighten Only
Overtightening may permanently damage product threads
and lead to failure of the retaining nut.

Do Not Use Tools
Use of tool(s) may damage product beyond repair and
potentially void product warranty.

Operating Temperature/Pressure

(psi) (bar)
180 12.4
170 11.7
160 11.0
150 10.3
140 9.7
130 9.0
120 8.3
110 7.6
100 6.9 \
90 6.2
80 55 \
70 438
60 4.1 \
50 3.4
40 28 \
30 241
20 14
10 7
0

°C -20 0 20 40 60 80 100 120
°F -4 32 68 104 140 176 212 248
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Specifications

General
Pipe size range............... DN15 to DN 900 (0.5 in. to 36 in.)
Flow Range

Minimum ..........c.c.o...... 0.05 m/s (0.15 ft/s)

Maximum ........ccccoeenee. 10 m/s (33 ft/s)
Linearity .......ccocvvvveennenn. + 1% reading plus 0.01 m/s (0.033 ft/s)
Repeatability................... + 0.5% of reading @ 25 °C (77 °F)
Min. Conductivity ............ 20 pS/cm

Wetted Materials
Sensor body and Electrodes and Grounding ring

-PO, -P1,-P2............... Polypropylene and 316L SS
-TO, -T1, -T2 PVDF and Titanium

-VO, -V1,-V2................ PVDF and Hastelloy-C
O-riNGS eeeeveeeeiieeiiene FKM (standard);

EPDM, FFKM (optional)

é The user is responsible for determining the chemical
suitability of these materials for a specific application.

Electrical

Power Requirements

41020 mMA ... 21.6 to 26.4 VDC, 22.1 mA max.
Frequency........ccceeeunee.. 510 26.4 VDC, 15 mA max.
Digital (S3L)....c..ccevvvennen. 5t0 6.5 VDC, 15 mA max.

Reverse polarity and short circuit protected
Current output (4 to 20 mA)

Loop Accuracy................ 32 pA max. error (25 °C @ 24 VDC)

Isolation .........cccuveeeennnen.. Low voltage < 48 VAC/DC from
electrodes and auxiliary power

Max cable .........cccccue.. 300 m (1000 ft)

Error condition. ................ 22.1 mA

Max. Loop Resistance....300 Q
Compatible with PLC, PC or similar equipment

Frequency output

Max. Pull-up Voltage....... 30 vDC

Compatible with Signet 8900, 9900, 9900-1BC, 9950

Digital (S°L) Output

Serial ASCII, TTL level 9600 bps

Compatible with Signet 8900, 9900, 9950 and 0486 Profibus
Concentrator

Max. cable length ..... Application dependent (See 8900 manual)

Environmental Requirements

Enclosure..........ccccccu..... NEMA 4X / IP65 (with cap installed)
Case ..ccoviiieiiiee PBT
Display.....ccccoevvvviieennnn. Polyamide
Storage Temperature......-20 °C to 70 °C (-4 °F to 158 °F)
Relative Humidity............ 0 to 95% (non-condensing)
Operating Temperature
Ambient.............cce -10°C to 70 °C (14 °F to 158 °F)
Media .....cocoviivenieennn 0°C to 85°C (32 °F to 185 °F)
Maximum

Operating pressure......10.3 bar @ 25 °C (150 psi @ 77 °F)
1.4 bar @ 85 °C (20 psi @ 185 °F)

Standards and Approvals

« CE, UL/CUL

* NSF (3-2551-P versions only)

* RoHS compliant

{e} China RoHS (visit gfsignet.com for details)

* Manufactured under ISO 9001 for Quality, ISO 14001
for Environmental Management and OHSAS 18001 for
Occupational Health and Safety.

FE Declaration of Conformity according to FCC Part 15
This device complies with Part 15 of the FCC rules.
Operation is subject to the following two conditions:

(1) This device may not cause harmful interference, and,
(2) This device must accept any interference received,
including interference that may cause undesired operation.

Quick Start

This manual contains the general installation, wiring and
calibration data for the Signet 2551-XX-11 Magmeter with
Frequency or Digital (S°L) data output, and for the Signet
2551-XX-12 Magmeter with 4 to 20 mA output. The basic
steps are outlined on this page. See each referenced section
for detailed information.

1. Configure the Hardware
2551-XX-11 ONLY: Position this Jumper to select
Digital (S°L) output or Frequency
output. Pg. 5.

2. Position the PIPE SIZE jumper according to your pipe
size. Pg. 5.

3. Install the Magmeter into the pipe. Use Signet
installation fittings ONLY. The installation fitting is critical
to Magmeter performance. Pg. 4.

4. Connect POWER and OUTPUT wiring.
Frequency out: Pg. 7.
Digital (S°L) out: Pg. 7.
4 to 20 mA out: Pg. 6.
GROUNDING  Without a good earth ground,
the Magmeter may not operate
efficiently. Pg. 6.

5. Route the wiring out through the two cable ports. Use
appropriate hardware to secure the 2551 from moisture
intrusion. One Liquid Tight Connector is included. Pg. 5.

Connect output signals and power
to this 4-terminal block.

2. ) Sensor

Pipe
Type Size

Jumper
Position

2551-PO/TOVO | %in. to 2% in. l]
DN15 to DN65 .
3in.to4in.

DN80 to DN100
2551-P1/T1/V1 | 5in.to 6 in.

DN125 to DN150

8in.

DN200 l‘

2551-P2/T2/V2 | 10in. to 12iin. l]
DN250 to DN300 03
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Installation

Pipe fittings

Georg Fischer offers a wide selection of installation fittings
that control the position of the Magmeter electrodes in relation
to the dimensions of the pipe. You will find a complete list of
order numbers for installation fittings in the Calibration Tables
on pages 8, 9.

Type Description
Plastic tees
Eﬁﬁ] * 0.5in. to 2 in. versions
:Eﬁl: « MPVC or CPVC
PVC Glue-on * 10in. and 12 in. only
Saddles » Cut 2% in. hole in pipe
% » Weld in place using solvent
cement
PVC Clamp-on e 2in.to4in., cut 1-7/16 inch
Saddles hole in pipe
* 6in.to 8in., cut 2-1/8 in. hole
in pipe
Iron Strap-on * 2in.to 4 in, cut 1-7/16 inch
saddles E hole in pipe
* Over 4 inch, cut 2-1/8 inch hole
in pipe
» Special order 14 in. to
36 in.

Iron, Carbon Steel &
316 Stainless Steel

Threaded Tees

0.5in. to 2 in. versions
Mounts on Threaded
pipe ends

Carbon steel & Stainless Steel

Weld-on Weldolets

2in.to 4 in., cut 1-7/16 inch
hole in pipe

Over 4 inch, cut 2-1/8 inch hole
in pipe

Fiberglass Tees

1.51in. to 2 in. PVDF insert
FPT

Union Fittings .
and Wafers = » For pipes from
DN 15 mm to 50 mm

PP or PVDF

Location of Fitting

To ensure the fluid velocity profile is Fully
Developed, without distortion from piping

Sensor Mounting Position

Horizontal pipe Runs

To minimize adverse effects of air pockets, sediment, or
excessive rotor wear (Paddlewheels), avoid mounting the flow
sensor at the top of the pipe (0°), bottom of pipe (180°), or the
sides (90° from vertical.

Vertical Pipe Runs

Mount flow sensors in any direction. To ensure pipe is flowing
full, with some back pressure, it's highly recommended the
fluid flow is upward.

Gravity and Discharge Lines
It's recommended to install a trap to ensure pipe is full during
flow conditions, and to minimize air pockets.

OK

system components, please adhere to the
recommended straight run geometry.

Reducer 90° Elbow
Y || (AA—> ] [ |
15 x 1.D. 5x1.D. ' 20 x I.D. 5x1.D.
2 x 90° Elbow

3 dimensions

Vertical flow is OK
if the pipe remains
full at all times.

Selecting a Location

accurate measurement.

into the 2551 electronics housing.

cause anomalies in the magmeter measurement.

* The 2551 requires a full pipe and a fully developed turbulent flow profile for

 In vertical installations, assemble the 2551 so the conduit ports are facing
downward. This prevents condensation inside the conduit from being directed

» Chemical injection systems can temporarily alter the fluid conductivity and

» To avoid this problem, install the magmeter UPSTREAM of the injection point.

2 x 90° Elbow E:L Pump/Valve
(— 1 |[C(r—T1 T — [ [T
g 25 x 1.D. 5x1.D. 40 x 1.D. 5x1.D. 50 x I.D. 5x1.D.
Injection Point 9900

N
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Hardware Configuration

Whether using the 2551-XX-11 (with frequency or Digital
(S3L) output) or the 2551-XX-12 (with 4 to 20 mA output), the
wiring terminals located on the inside of the yellow cover are

equipment (PLC, Datalogger, Chart Recorder, Flow meter,
etc.) are made at the large 4-position terminal connector.

When the cover is removed the wiring from the sensor can
be seen connected to the smaller terminal block. These
connections should always remain connected to prevent
inadvertent damage or miswiring.

The terminals on the 2551 Magmeter are designed for
conductors from 16 AWG to 22 AWG.

f WARNING!

If the second conduit port is used, carefully drill
the opening. (The plastic is too strong to be
punched out.)

identical. All of the connections from the Magmeter to external

JP2 is for factory use only.
MAKE NO CONNECTIONS.

This blue jumper selects —)

frequency output or
SSL serial data output
in the 3-2551-XX-11
(Not used on 2551-XX-12 models)

\\

The user must connect output cables to

this 4-terminal block.

The factory connects
the sensor cable to the terminals
inside the yellow cover.

Blue
Brown
Black
Red
Yellow
White
Not used

Set this blue jumper according to the pipe size.
S~

Sensor Type Pipe Size

Jumper Position

2551-P0O/TO/VO Y in. to 2% in.

DN15 to DN65

2551-P0/TO/VO 3in.to4in.

DN80 to DN100

2551-P1/T1V1 5in.to 6in.

DN125 to DN150

2551-P1/T1/V1 8in.

DN200

10in. to 121in.
DN250 to DN300

2551-P2/T2IV2 ‘

-

» Secure the Magmeter in a vise to prevent

damage or injury.
» The plastic inside the port is very thin.
Do not allow the drill to penetrate too deeply

and damage the Magmeter wiring. 3-9000.392-1

(one supplied)
Important:
* The directional arrow on the sensor body MUST be pointed DOWNSTREAM for correct
operation. (Digital (S°L) and 4 to 20 mA will not work if flow is against direction of arrow).
* The FLOW arrow decal can be placed directly on the pipe to identify the direction of flow.
» Use a cable gland or a liquid tight connector to seal the cable ports from water intrusion.
» The yellow housing may be reversed to align the conduit ports as required.
« If the Magmeter is installed on a vertical pipe, the conduit ports should be turned to
point downward.
+ This will prevent condensation from being channeled into the enclosure.
* Use plumber's tape or a suitable sealant on cable ports.

WARNING!

Liquid tight connector

Use the yellow decal
to mark the direction
of flow on the pipe

Do not use any tools to
tighten the yellow retaining
cap. DO NOT USE thread
sealant or lubricants on

e retaining cap!

FAILURE TO FOLLOW THESE INSTRUCTIONS MAY RESULT IN

Lubricate O-rings with a viscous
non-petroleum based lubricant
(grease) compatible with the system.

THE SENSOR BEING EJECTED FROM THE PIPE!

DO NOT USE ANY TOOLS ON THE RETAINING CAP.

HAND TIGHTEN ONLY.
LUBRICATE O-RINGS WITH A NON-PETROLEUM BASED,

DO NOT USE thread sealant or
lubricants on the fitting threads.

VISCOUS LUBRICANT (GREASE) COMPATIBLE WITH
THE SYSTEM.

DO NOT USE THREAD SEALANT OR LUBRICANTS ON THE RETAINING CAP OR ON THE PLASTIC FITTING THREADS.

IF LEAKING IS OBSERVED FROM THE RETAINING CAP, IT INDICATES DEFECTIVE OR WORN O-RINGS ON THE SENSOR.
DO NOT ATTEMPT TO CORRECT BY FURTHER TIGHTENING.

CHEMICAL COMPATIBILITY WARNING

The retaining nuts of Magmeters are not designed for prolonged contact with aggressive substances. Strong acids, caustic substances
and solvents or their vapor may lead to failure of the retaining nut, ejection of the sensor and loss of the process fluid with possibly
serious consequences, such as damage to equipment and serious personal injury. Retaining nuts that may have been in contact with
such substances, e.g. due to leakage or spilling, must be replaced.

+GF+ 2551 Blind Magmeter



General Installation and Grounding Tips

Sensor conditioning
The Magmeter output signal may be unstable immediately after installation. Allowing the sensor to soak in a full pipe (or in any
container of water) for 24 hours will stabilize the performance.
» Very low conductivity fluids may require a longer conditioning period. (The Magmeter will not operate properly in fluids where
the conductivity is less than 20 yS/cm.)

Grounding
The 2551 Magmeter is unaffected by moderate levels of electrical noise. However, in some applications it may be necessary to
ground portions of the system to eliminate electrical interference. The grounding requirements will vary with each installation.

1. One or more of the following steps may be applied if the
2551 Magmeter is affected by electrical noise: Do not terminate i i X
» The ground terminal on the outside of the yellow housing @ eyt at Magmeter ) @
is connected internally to the grounding ring at the tip of nstrument S I
the sensor. 'r' ------ = /
) 1]

+ Connect a wire (14 AWG/2.08 mm?recommended) from T
this terminal directly to a local Earth ground. =

2. Install fluid grounding devices immediately upstream and Sensor
Grounding ring

downstream of the Magmeter.
» Connect the fluid grounds to the Earth ground terminal on

the 2551. e
e

/

Earth ground

» Use flanged grounding rings or metal electrodes on plastic
pipes, or metal clamps on metal pipes.
 Fluid grounds must be in direct contact with the fluid, and

- 4in. to 50 in. 4 in. to 50 in.
as near to the Magmeter as possible. «—>
(10cmto 1.3 m) (10cmto 1.3 m)

3. The shield from the output cable must be terminated at the —— o
remote instrument ONLY. I ©) " instan betoon famae, . (2) T
This shield must be connected at only one end! metal s"ap:gn metal pipe

4. Connect an additional wire (minimum AWG 14/2.08 mm?)
from the remote instrument ground to the Magmeter
ground terminal.

Wiring with 4 to 20 mA Loop Output

The 2551-XX-12 Magmeter is a traditional 2-wire passive 4 to 20 mA
loop transmitter.
» External loop power (24 VDC + 10%) is required. See Ordering Information for power supplies.
* The maximum loop resistance the Magmeter can accommodate is 300 Q.
+ All 2551-XX-12 Magmeters are shipped from the factory with the 4 to 20 mA output scaled for 0 to 5 m/s (0 to 16.4 ft/s). If this
operating range is suitable, no adjustments are necessary.
» The Calibration Tables on pages 8-9 list the 20 mA setpoint for each installation fitting. Use this information to program the
4 to 20 mA range of the loop device (PLC, Datalogger, recorder, etc.)

» The 3-0252 USB to Digital (S°L) Configuration/Diagnostic Tool is required to change the operating range.

2551 Magmeter

Loop - (Ground) 4-20 mA Loop

monitor

(Maximum 300 Q)
Loop + (24 VDC) ——| 24 VDC £ 10%

6 2551 Blind Magmeter +GF+



Wiring with Frequency or Digital (S°L) Output

Frequency output (Compatible with all POWERED Signet Flow instruments.)

» When the blue jumper illustrated here is placed over both pins, the 2551-XX-11 outputs
an open collector frequency signal that can be connected to any powered Signet flow
meter (models 8900, 9900, 9900-1BC, 9950).

» 5VDC power is provided to the 2551 Magmeter by all Signet flow instruments.

No additional power is required.

* The frequency output will be displayed as positive flow regardless of the

flow direction.

Digital (S°L) Output (Compatible with 8900 Multi-Parameter Controller, 9900
and 9950 Transmitter)

* When the blue jumper illustrated here is removed (or placed over one pin for storage)
the 2551-XX-11 outputs a Digital (S3L) signal compatible with the Signet 8900, 9900
and 9950.

* The 2551 receives 5 VDC power from the 8900, 9900 or 9950. No additional power
is required.

e The 8900 will display 0 (Zero) flow rate during periods of reverse flow.

The 9900 will display negative numbers to indicate reverse flow.

» The maximum cable length from the 2551 to the 8900 or 9900 depends on the 8900 or

9900 configuration. Refer to the 8900, 9900 or 9950 manual for complete information.

Blue Jumper ON = FREQ OUT

Frequency
[ce
Q-
§ | @3

Blue Jumper OFF = S3L OUT

S3L
[Cele
Q-
@‘ 03\

programing instructions.

2551 Wiring to Signet 8900 2551 Wiring to Signet 9900 and 9900-1BC
9900 Transmitter
@ 4 | Notused
O @
Freq. 3 | Ground f Z' zZ ,:E
2 | Data > U o
1/0 Module 3-8900.401-X 389006216
Frequency ~ TOVDC (Black) IR 1] +5VDC 2551 Magmeter E m
Input Freq. Input (Red) BIE L
1 GND (Shield) 5 g 2551 Magmeter
Froqueney  +5VDC (Black)| ||+ (L1l o 0og Not used
'“g‘:z Freq. Input 2 (Red)| | |5 [T1] (I | 1 Ground
= S3L (Red)| |[¢ [Tl
8" GND (White/shield)| | |7 [TTI :l sy Frequency or SL
, +5VDC (Black) |[s [TH] b
it S3L (Red) ||o [TH] U o
GND (White/Shield) | |10 [T2] 4 |
W =
2551 Wiring to Signet 9950
9950 S°L Inputs 9950 Frequency
DC POWER DC POWER
5 o LL] Frequency L0
S'L ~ [ o: "
[ ] T 1] T 1]
@+ LT | ol LI | TSens_orI Signal
0 g mE| [ ] ®: [T ermina
[ ool [CT4 toof L4 1 Black (+V)
Loo m |I Lool m |I
Black == [; Black =0 [ v 2 Red (S3L/Freq)
No connection X _| m FREQ Red FR'E FREQ 3 White (GND)
Red e =T DATA No connection X = | [T} DATA
White iﬁ |I GND White iﬁm |I GND 4 Not Used
Shield %FR % || Shield %FR % |I
L o A of
= J | = 4 Jf
[ = ===

Refer to the 0486 Profibus Concentrator manual for Frequency or Digital (S3L) wiring and

+GF+
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Wiring with Frequency Other Manufacturer's Equipment

2551 Frequency Out to other manufacturer's equipment

* A 10 KQ pull-up resistor (not supplied) must also be connected

If connecting the 2551 Magmeter to a flow instrument from another
manufacturer, 5 to 24 VDC power must be provided to the 2551.

between terminals 1 and 2.

10KQ

Calibration and Software Configuration

2551 Magmeter

Not used

Ground

Frequency Out —»

<— 5-24 VDC

Install a pull-up resistor when connecting the

2551 Magmeter to other manufacturer's flowmeters.

No calibration is necessary to begin using the 2551. The application and performance settings are pre-set to meet the requirements
of most applications.

The 2551 application and performance settings can be customized using the Signet 3-0252 Configuration Tool and software. Refer
to the Signet 3-0252 ConfigurationTool manual for details to adjust the following parameters:

4 to 20 mA span: Factory setting is 0 to 5 m/s. Can be customized to any range.
Noise Rejection Filter: Factory set for 60 Hz. Can be changed to 50 Hz.
Low Flow Cutoff: Factory setting is 0.05 m/s. Can be customized to any velocity.

Averaging Time: Factory setting is 14 seconds. Can be customized from 0.1 seconds to 100 seconds.
Sensitivity: Factory setting is 25% of full scale. Can be customized to any % of full scale.

2551 Blind Magmeter
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Averaging and Sensitivity

Even the most carefully engineered flow systems may
experience erratic and unstable conditions. If the instability is
communicated to the output functions, the results may create
problems for control devices.

To alleviate these issues, the 2551 provides two adjustments
that operate in tandem. The information here will help

in determining the appropriate settings for any specific
application.

Averaging
» The AVERAGING setting dictates the time over which the
magmeter will average the flow signal.

» The LCD display is updated every second. With averaging
at 14 seconds, the flow rate on the display is an average of
the previous 14 seconds input.

» Short averaging times provide the fastest display and output
response to changes in the flow rate.

» Higher averaging times help to smooth the display and
current output where the flow in the pipe is erratic or
unstable due to installation limitations.

Sensitivity

* The SENSITIVITY setting determines how the 2551
responds to sudden surges in the flow rate. It "overrides"
the Averaging function just long enough to allow an actual
change in flow rate to be displayed, then resumes the
averaging. The result is a smooth flow display and a quick
response to large shifts in the flow rate.

» The settings for Sensitivity represent a percentage of the

+ Example: A sensitivity setting of 25% means that the flow
rate must change instantly and by more than 2.5 ms before
the function is enabled.

NOTE: The SENSITIVITY function is ineffective if the
AVERAGING function is set to zero.

A CAUTION

The SENSITIVITY function changes the
response characteristics of the magmeter.

If used as part of a tuned closed loop control
system, such a change may be undesirable.

magmeter's maximum range, or 10 meters per second (m/s).

No Averaging

With AVERAGING set to zero, the flow rate will be displayed
immediately and with no filtering. This line represents the
actual output of the flow sensor as it responds to unstable flow
conditions in the pipe.

a 4 ]
By ‘:| .{.'l 'I:I‘ D
v felpur ? L Y
CURARE A
R IR LI
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-
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Velocity
i K

Time 10s  20s  30s  40s 50s  60s  70s

Averaging Only

With AVERAGING set to 50 seconds and SENSITIVITY still
set to zero the flow rate is stabilized, but a sharp change in
flow rate is not represented on the display or at the output for
50 seconds or longer.

|||||||||||||

Velocity

.........

Averaging and Sensitivity
With AVERAGING at 50 seconds and SENSITIVITY set to
25%, the flow rate is stabilized, while the sudden shift in flow

is reflected very quickly.

Velocity

Time 10s  20s  30s  40s  50s  60s  70s

+GF+

2551 Blind Magmeter



Calibration Data: K-Factors and Full Scale Current Values

Plastic Installation Fittings: PVC Tees and Saddles

PIPE PULSE! | PULSE/| 20mA | S0mA.
m m
?Ilﬁl)E FITTING TYPE U.S. GAL LITERS Fac'torxl Fac_torxv
setting " | setting

SCH 80 PVC-U TEES FOR SCH 80 PVC PIPE
1/2 MPV8T005 2277.00 601.58 12 45
3/4 MPV8TO007 1407.60 371.90 22 84
1 MPV8T010 861.17 227.52 37 139
1-1/4 MPV8T012 464.91 122.83 66 248
1-1/2 MPV8TO015 331.43 87.56 90 342
2 MPV8T020 192.89 50.96 151 572
SCH 80 PVC TEES FOR SCH 80 PVC PIPE
2-1/2 PV8T025 131.46 34.73 217 820
3 PV8TO030 82.52 21.80 338 1278
4 PV8T040 44.78 11.83 588 2225
SCH 80 CPVC TEES FOR SCH 80 CPVC PIPE
1/2 MCPV8T005 2496.03 659.45 12 45
3/4 MCPV8T007 1381.48 364.99 22 84
1 MCPV8T010 857.98 226.68 37 139
1-1/4 MCPV8T012 44517 117.61 66 248
1-1/2 MCPV8T015 325.56 86.01 90 342
2 MCPV8T020 206.07 54.45 151 572
SCH 80 PVC SADDLES FOR SCH 80 PVC PIPE
2 PV8S020 193.83 51.21 151 572
2-1/2 PV8S025 138.01 36.46 217 820
3 PV8S030 83.89 22.16 338 1278
4 PV8S040 40.88 10.80 588 2225
6 PV8S060 22.53 5.95 1333 5045
8 PV8S080 12.52 3.31 2335 8838
10 PV8S100 7.94 2.10 3673 13905
12 PV8S120 5.71 1.51 5197 19672
SCH 80 PVC SADDLES FOR SCH 40 PVC PIPE
2 PV8S020 180.01 47.56 172 651
2-1/2 PV8S025 123.72 32.69 245 927
3 PV8S030 75.81 20.03 378 1433
4 PV8S040 41.87 11.06 652 2469
6 PV8S060 19.71 5.21 1480 5601
8 PV8S080 11.73 3.10 2557 9680
10 PV8S100 7.43 1.96 4032 15262
12 PV8S120 5.23 1.38 5725 21671
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Calibration Data: K-Factors and Full Scale Current Values

Plastic Installation Fittings for Metric Pipes:
Polypropylene True Union Tees and Wafers
PVDF True Union Tees, PVC True Union Tees

Metal Installation Fittings
Iron Saddles

PIPE | Errring | PULSE | puLse (;:rl:‘n: t Ii:m:t PIPE | pirring | PULSE | PULSE 35.'3,": t IE::: t
SIZE TYPE IU.S. LITERS | Factory | Factory SIZE TYPE IU.S. / Factory | Factory
(IN.) GAL g I (IN.) GAL |LITERS 4 g4
setting setting setting"” | setting
POLYPROPYLENE FITTINGS (DIN/ISO, BS, ANSI) SCH 80 IRON SADDLE ON SCH 80 PIPE
DN15 | PPMT005 | 2192.73| 579.32 16 62 |2 IR8S020 194.85| 51.48 151 572
DN20 |PPMT007 | 1327.81| 350.81 26 98| |2-1/2 |IR8S025 142.28 | 37.59 217 820
DN25 |PPMTO10 | 737.16| 194.76 43 162 | |3 IR8S030 87.53| 23.13 338 1278
DN32 |PPMTO12 | 453.46| 119.81 66 250 |4 IR8S040 4062 10.73 588 2225
DN40 |PPMTO15 | 275.03 72.66 104 392 |5 IR8S050 29.28 7.74 930 3521
DN50 | PPMT020 | 164.17 43.37 164 623 |6 IR8S060 22.30 5.89 1333 5045
8 IR8S080 12.52 3.31 2335 8838
PVDF FITTINGS (DIN/ISO, BS, ANSI) 10 IR8S100 7.94 2.10 3673 13905
DN15 | SFMTO005 | 1946.49 | 514.26 16 62 |12 IR8S120 5.65 1.49 5197 | 19672
DN20 |SFMT007 | 1158.05  305.96 28 106
DN25 |SFMTO010 | 749.09| 197.91 46 174 | | SCH 80 IRON SADDLE ON SCH 40 PIPE
DN32 |SFMTO012 | 439.51 116.12 77 292 | |2 IR8S020 185.35| 48.97 172 651
DN40 |SFMTO015 | 248.93 65.77 121 456 | | 2-1/2 | IR8S025 127.47| 33.68 245 927
DN50 | SFMT020 146.85 38.80 202 766 |3 IR8S030 76.62 | 20.24 378 1433
4 IR8S040 40.23| 10.63 652 2469
PVC FITTINGS (DIN/ISO, BS, ANSI) 5 IR8S050 27.32 7.22 1024 3877
DN15 | PVMTO005 | 2067.76 | 546.30 18 68 |6 IR8S060 19.71 5.21 1480 5601
DN20 |PVMTO007 | 1136.61  300.29 28 106 | |8 IR8S080 11.61 3.07 2557 9680
DN25 |PVMTO10 | 716.52| 189.31 46 174 | |10 IR8S100 7.36 1.94 4032 15262
DN32 |PVMTO012 | 446.07 117.85 72 272 |12 IR85120 5.18 1.37 5725| 21671
DN40 |PVMTO15 | 278.83 73.67 13 428
DN50 |PVMT020 | 159.36 42.10 179 677

+GF+
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Calibration Data: K-Factors and Full Scale Current Values

Metal Installation Fittings:
Carbon Steel Tees and Weld-o-Lets
Stainless Steel Tees and Weld-o-Lets, Galvanized Iron Tees

Metal Installation Fittings:
Bronze and Copper Tees and Brazolets

"GPM at | "LPM at "GPM | "LPM at
ror | Frng | FULSE (puLsEs 20mA | 20mA | | EPF | FITTING | PULSE/ PULSE/ at20mA 20mA
(IN.) TYPE GAL LITERS Facfonl(l Fac?orYI (IN.) TYPE U.S. GAL | LITERS Fac?on'(' Fac?or)l/.

setting” | setting setting” | setting

CARBON STEEL TEES ON SCH 40 PIPE BRONZE TEES ON SCH 40 PIPE
1/2 CS4T005 | 1572.66 | 415.50 15 58| |1 BR4T010 582.34 153.86 44 168
3/4 CS4T007 | 1086.73 | 287.11 27 102 | |1-1/4 BR4T012 330.54 87.33 76 289
1 CS4T010 582.34 | 153.86 44 168 | | 1-1/2 BR4T015 254.76 67.31 104 394
1-1/4 CS4T012 377.48 99.73 76 289 |2 BR4T020 157.36 41.58 172 651
1-1/2 CS4T015 267.79 70.75 104 394
2 CS4T020 167.85 44.35 172 651 | | COPPER TEES FITTING ON COPPER PIPE SCH K
1/2 CUKTO005 | 2459.19 | 649.72 11 42
STAINLESS STEEL TEES ON SCH 40 PIPE 3/4 CUKTO007 | 1108.02 292.74 22 84
1/2 CRA4T0O05 | 1601.26 | 423.05 15 58 1 CUKTO010 649.87 171.70 40 150
3/4 CR4T007 937.78 | 247.76 27 102 11-1/4 | CUKTO12 422,03 11150 62 236
1 CR4T010 606.18 | 160.15 44 168 | | 1-1/2 CUKTO015 281.43 74.35 88 333
1-1/4 CR4T012 279.68 73.89 76 289 2 CUKT020 136.02 35.94 154 583
1-1/2 CR4T015 147.65 39.01 104 394
2 CR4T020 111.90 29.56 172 651| | COPPER TEES FITTING ON COPPER PIPE SCH L
1/2 CUKTO005 | 2406.30| 635.75 11 42
STAINLESS STEEL WELDOLETS ON SCH 40 PIPE 3/4 CUKTO007 | 1174.77 | 310.37 22 84
2-1/2 CR4W025 106.31 28.09 245 927 1 CUKTO010 672.28 177.62 40 150
3 CR4W030 72.27 19.09 378 1433 | |1-1/4 | CUKT012 402.84| 106.43 62 236
4 CR4W040 36.84 9.73 652 2469 | | 1-1/2 | CUKTO15 294.99 77.94 88 333
5 CR4W050 29.28 7.73 1024 3877 |2 CUKT020 149.63 39.53 154 583
6 CR4W060 20.29 5.36 1480 5601
8 CR4W080 11.73 3.10 2557 9680 | | COPPER/BRONZE BRAZOLET ON SCH 40 PIPE
10 CR4W100 7.45 1.97 4032 15262 | | 2-1/2 | BR4B025 117.31 30.99 245 927
12 CR4W120 5.24 1.39 5725 21671 3 BR4B030 78.62 20.77 378 1433
4 BR4B040 45.13 11.92 652 2469
CARBON STEEL WELDOLETS ON SCH 40 PIPE 5 BR4B050 32.79 8.66 1024 3877
2-1/2 CS4W025 105.70 27.93 245 927 6 BR4B060 22.73 6.01 1480 5601
3 CS4W030 70.68 18.67 378 1433 | |8 BR4B080 13.14 3.47 2557 9680
4 CS4W040 36.38 9.61 652 2469 10 BR4B100 8.34 2.20 4032 15262
5 CS4W050 29.28 7.73 1024 3877 | |12 BR4B120 5.87 1.55 5725 21671
6 CS4W060 20.29 5.36 1480 5601
8 CS4W080 11.73 3.10 2557 9680
10 CS4W100 7.45 1.97 4032 15262
12 CS4W120 5.24 1.39 5725| 21671
GALVANIZED IRON TEES ON SCH 40 PIPE
1 IR4T010 558.50 | 147.56 44 168
1-1/4 IR4T012 334.45 88.36 76 289
1-1/2 IR4T015 248.97 65.78 104 394
2 IR4T020 146.00 38.57 172 651




Maintenance

Troubleshooting

Environmental Recommendations:
» When used properly, this product presents no inherent danger to the environment.

The 2551 Magmeter requires very little maintenance. There are no user-serviceable components in the Magmeter.
« If the fluid contains deposits and solids that may coat the electrodes, a regular cleaning schedule is recommended.

» Do not use abrasive materials on the metal electrodes. Clean with soft cloth and mild detergent only.

» Use a cotton swab and mild detergent to remove deposits on the metal electrodes at the tip of the sensor.

» Please follow local ordinances when disposing of this or any product with electronic components.

Symptom

Possible Cause

Solution

Output is erratic
and unstable.

Magmeter installed too close to upstream
obstruction.

Relocate the magmeter to have straight
uninterrupted pipe upstream of the sensor
for at least 10 x the pipe diameter.

Magmeter located in area exposed to air
bubbles/pockets.

Eliminate air bubbles in the pipe.

Magmeter is installed in pipe backwards.

Remove the magmeter and reinstall with
the flow direction arrow on the sensor body
pointed DOWNSTREAM.

Electrical noise is interfering with the
measurement.

Review the grounding of the magmeter and
the pipe. Install adequate Earth ground to
allow the Magmeter to operate properly.

Electrodes are coated with solids.

Carefully clean the electrodes. Refer to
sensor manual for details.

New sensor; metal surface not properly
conditioned.

Soak sensor overnight in fluid.

Output is not 0 when flow
is stopped.

Electrodes not adequately conditioned.

Soak sensor overnight in fluid.

Vibration or other movement in pipe causes
magmeter to detect flow.

Increase the Low Flow Cutoff.

Electrical noise interference.

Modify grounding to protect the Magmeter
from interference.

Defective Magmeter.

Return to factory for service.

4-20 mA current output
is incorrect.

Loop device not scaled same as Magmeter.

Use 3-0252 Setup tool to re-span the
Magmeter to match Loop device.

Re-span Loop device to match Magmeter.

Range Jumper not placed correctly.

Set Range Jumper correctly.

Defective Magmeter.

Return to factory for service

Frequency output is
inoperative

Digital (S°L) output is
inoperative.

Loop output is
inoperative.

2551 is wrong model.

Frequency/S3L model: 3-2551-XX-11

Blue jumper not in correct position.

Place blue jumper correctly. (Pg. 4)

Wiring is not correct.

Check wiring, make corrections. (Pg. 7)

Frequency input to other manufacturer's
flow instrument does not have pull-up
resistor.

Install 10 kQ resistor. (Pg. 7)

Output is 22.1 mA

Conductivity is less than 20 pS/cm (the fluid
is too clean for Magmeter).

Unsuitable application for Magmeter.

Electronic component failure.

Return 2551 to factory.

+GF+

2551 Blind Magmeter 13



Troubleshooting continued

Troubleshooting with the RED and BLUE LEDs

Both Off: The power is off or the sensor is not connected.

Solid Blue: The power is on, the pipe is full, but there is no flow in the pipe.
Blinking Blue: Normal operation, blink rate is proportional to the flow rate.
Alternating Red-Blue: Empty pipe indication (electrodes are not wet). l
Blinking Red: System errors (electrical noise interference).

Solid Red: Instrument error (defective electronics component).

If the 2551 detects an empty pipe: \_
» Frequency output will be locked to 0 Hz if electrodes are not wet.

« Digital (S3L) output will be locked to 0 if electrodes are not wet.
* 4 to 20 mA will be locked to 4 mA if electrodes are not wet.
» Blue and red LEDs will blink alternately if electrodes are not wet.

If the 2551 detects REVERSE FLOW:
* Frequency out cannot distinguish reverse flow from forward flow. The output will be the absolute value.
« With Digital (S°L) output, reverse flow results in 0 flow rate displayed on 8900 or with negative numbers on the 9900 and 9950.
* 4-20 mA output can be spanned into negative flow range using the USB Configuration Tool and software.
(Page 7) (example: 4-20 mA = —-100 to +100 GPM).

14 2551 Blind Magmeter +GF+



Ordering Information

Accessories and Replacement Parts

Mfr. Part No. Code
O-Rings

1220-0021 198 801 000
1224-0021 198 820 006
1228-0021 198 820 007
Replacement Transducers
3-2551-P0 159 001 211
3-2551-P1 159 001 212
3-2551-P2 159 001 444
3-2551-T0 159 001 213
3-2551-T1 159 001 214
3-2551-T2 159 001 445
3-2551-V0 159 001 376
3-2551-V1 159 001 377
3-2551-V2 159 001 446
Replacement Electronics Module
3-2551-11 159 001 215
3-2551-12 159 001 216
3-2551-21 159 001 372
3-2551-22 159 001 373
3-2551-41 159 001 374
3-2551-42 159 001 375
Other

P31536 198 840 201
7310-1024 159 873 004
7310-2024 159 873 005
7310-4024 159 873 006
7310-6024 159 873 007
7310-7024 159 873 008
3-8050.390-1 159 001 702
3-8050.390-3 159 310 116
3-8050.390-4 159 310 117
3-9000.392-1 159 000 839
3-0252 159 001 808

Description

O-ring, FKM (2 required per sensor)
O-ring, EPR (EPDM) (2 required per sensor)
O-ring, FFKM (2 required per sensor)

PP/316L SS, DN15 to DN100 (Y2 to 4 in.) pipe
PP/316L SS, DN125 to DN200 (5 to 8 in.) pipe
PP/316L SS, DN250 to DN900 (10 to 36 in.) pipe
PVDF/Titanium, DN15 to DN100 (*2 to 4 in.) pipe
PVDF/Titanium, DN125 to DN200 (5 to 8 in.) pipe
PVDF/Titanium, DN250 to DN90O0 (10 to 36 in.) pipe
PVDF/Hastelloy-C, DN15 to DN100 (%2 to 4 in.) pipe
PVDF/Hastelloy-C, DN125 to DN200 (5 to 8 in.) pipe
PVDF/Hastelloy-C, DN250 to DN900 (10 to 36 in.) pipe

Magmeter electronics, frequency or digital (S3L) output

Magmeter electronics, 4 to 20 mA output

Magmeter display electronics, frequency or digital (S3L) output, with relays
Magmeter display electronics, 4 to 20 mA output w/relays

Magmeter display electronics, frequency or digital (S3L) output

Magmeter display electronics, 4 to 20 mA output

Sensor plug, Polypropylene

24 \VDC Power Supply, 0.42 A, 10W

24 VDC Power Supply, 1.0 A, 24W

24 VVDC Power Supply, 1.7 A, 40W

24 VDC Power Supply, 2.5 A, 60W

24 VDC Power Supply, 4.0 A, 96W
Retaining Nut Replacement Kit, NPT, Valox
Retaining Nut Replacement Kit, NPT, PP
Retaining Nut Replacement Kit, NPT, PVDF
Liquid-tight connector kit, 1 set, 2 in. NPT
0252 Configuration tool

+GF+
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Ordering Information

4 to 20 mA output

Mfr. Part No.
3-2551-P0-12
3-2551-T0-12
3-2551-V0-12
3-2551-P1-12
3-2551-T1-12
3-2551-V1-12
3-2551-P2-12
3-2551-T2-12
3-2551-V2-12

Code

159 001 110
159 001 113
159 001 259
159 001 111
159 001 114
159 001 260
159 001 112
159 001 449
159 001 451

Description

DN15 to DN100 (2 to 4 in.), Polypropylene and 316L SS
DN15 to DN100 (Y2 to 4 in.), PVDF and Titanium

DN15 to DN100 (% to 4 in.), PVDF and Hastelloy-C

DN125 to DN200 (5 to 8 in.), Polypropylene and 316L SS
DN125 to DN200 (5 to 8 in.), PVDF and Titanium

DN125 to DN200 (5 to 8 in.), PVDF and Hastelloy-C

DN250 to DN90O0 (10 to 36 in.), Polypropylene and 316L SS
DN250 to DN900 (10 to 36 in.), PVDF and Titanium

DN250 to DN900 (10 to 36 in.), PVDF and Hastelloy-C

Frequency or Digital (S3L) output programmable open collector

Mfr. Part No. Code Description

3-2551-P0-11 159 001 105 DN15 to DN100 (% to 4 in.), Polypropylene and 316L SS
3-2551-T0-11 159 001 108 DN15 to DN100 (% to 4 in.), PVDF and Titanium
3-2551-V0-11 159 001 257 DN15 to DN100 (% to 4 in.), PVDF and Hastelloy-C
3-2551-P1-11 159 001 106 DN125 to DN200 (5 to 8 in.), Polypropylene and 316L SS
3-2551-T1-11 159 001 109 DN125 to DN200 (5 to 8 in.), PVDF and Titanium
3-2551-V1-11 159 001 258 DN125 to DN200 (5 to 8 in.), PVDF and Hastelloy-C
3-2551-P2-11 159 001 107 DN250 to DN900 (10 to 36 in.), Polypropylene and 316L SS
3-2551-T2-11 159 001 448 DN250 to DN900 (10 to 36 in.), PVDF and Titanium
3-2551-V2-11 159 001 450 DN250 to DN900 (10 to 36 in.), PVDF and Hastelloy-C
+GF+
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English

Operating Instructions

The 2551 Magmeter measures the flow rate in a full pipe by monitoring the voltage
produced when the (conductive) fluid moves through a magnetic field. Output
+GF+ options include a traditional frequency signal, a serial data (Digital (S°L)) output,
REL i and a 4 to 20 mA output.
The 2551 Magmeter is available in three sizes that will accommodate pipes from
2 inch through 36 inch diameters.
Sk Maghaates Select from three different material combinations to match the Magmeter to the
application requirements.
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Warranty Information

Refer to your local Georg Fischer Sales office for the most
current warranty statement.

All warranty and non-warranty repairs being returned must
include a fully completed Service Form and goods must be
returned to your local GF Sales office or distributor.
Product returned without a Service Form may not be
warranty replaced or repaired.

Signet products with limited shelf-life (e.g. pH, ORP, chlorine
electrodes, calibration solutions; e.g. pH buffers, turbidity
standards or other solutions) are warranted out of box but not
warranted against any damage, due to process or application
failures (e.g. high temperature, chemical poisoning, dry-out) or
mishandling (e.g. broken glass, damaged membrane, freezing
and/or extreme temperatures).

Product Registration

Thank you for purchasing the Signet line of Georg Fischer
measurement products.
If you would like to register your product(s), you can now
register online in one of the following ways:
* Visit our website www.gfsignet.com.
Under Service and Support click on
Product Registration Form
« If this is a pdf manual (digital copy), click here

Safety Information

2. Confirm chemical compatibility before use.

3. Do not exceed maximum temperature / pressure
specifications.

4. Wear safety goggles or faceshield during installation/service.

Do not alter product construction.

o

Caution / Warning / Danger
A Indicates a potential hazard. Failure to follow all warnings
may lead to equipment damage, injury, or death
Electrostatic Discharge (ESD) / Electrocution Danger
% Alerts user to risk of potential damage to product by

ESD, and/or risk of potential of injury or death via
electrocution.

m | Personal Protective Equipment (PPE)
[b Always utilize the most appropriate PPE during

installation and service of Signet products.

) ﬁ, Pressurized System Warning

L7/~ | Sensor may be under pressure, take caution to vent
%%” f;??: system prior to installation or removal. Failure to do so
may result in equipment damage and/or serious injury.

i
Qmﬂj Hand Tighten Only

Overtightening may permanently damage product
threads and lead to failure of the retaining nut.

Do Not Use Tools
Use of tool(s) may damage product beyond repair and
potentially void product warranty.

Note / Technical Notes
Highlights additional information or detailed procedure.

1. Depressurize and vent system prior to installation or removal.

Chemical Compatibility

The retaining nuts of Magmeters are not designed for
prolonged contact with aggressive substances. Strong acids,
caustic substances and solvents or their vapor may lead to
failure of the retaining nut, ejection of the sensor and loss of
the process fluid with possibly serious consequences, such as
damage to equipment and serious personal injury. Retaining
nuts that may have been in contact with such substances e.g.
due to leakage or spilling, must be replaced.

—
L T o T e

Do not use any tools to

tighten the yellow retaining cap.
DO NOT USE thread sealant or
lubricants on retaining cap!

Lubricate O-rings with a
non-petroleum based, viscous
lubricant (grease) compatible
with the system.

~<—— DO NOT USE thread sealant
or lubricants on the fitting threads!

Failure to follow these instructions may result
in the sensor being ejected from the pipe!

If leaking is observed from the retaining cap, it . }\ ;
indicates defective or worn o-rings on the sensor. 3 iy 7/

A,
Do not attempt to correct by further tightening. ‘5\'\:\ ;j/}?

95.3 mm

(3.75in) " >

3

‘F
r

116.8 mm
(4.6in.)

S
MM — Y

A
=> -X0
-X1
-X2
Y
Pipe Range Insertion Depth
z2in. to 4in. -X0 =58 mm (2.3in.)
5in. to 8in. -X1=91mm (3.6in.)
10in. to 36in. [ -X2 = 167 mm (6.6 in.)

X = Sensor Body Material (P, T, or V)

2 Signet 2551 Display Magmeter
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Specifications

General

Pipe size range.............. DN15 to DN90O (Y2 in. to 36 in.)

Flow Range ................... Minimum: 0.05 m/s (0.15 ft/s)
(Bi-directional) ............... Maximum: 10 m/s (33 ft/s)

Linearity .......ccccoevvveennnen. +1% of reading +0.01 m/s (0.033 ft/s)
Repeatability.................. +0.5% of reading @ 25 °C (77 °F)

Minimum Conductivity ...20 uS/cm

Wetted Materials
Sensor body and Electrodes and Grounding ring:

-PO, -P1,-P2.............. Polypropylene and 316L SS

-TO, -T1, -T2 PVDF and Titanium

VO, -V1,-V2..oeennn. PVDF and Hastelloy-C

O-rings ...ccvvvveeeee FKM (standard) EPDM, FFKM
(optional)

The user is responsible for determining
A the chemical suitability of these materials

for a specific application.

Power Requirements

41020 MA .. 21.6 to 26.4 VDC, 22.1 mA max.
400 mV p-p maximum ripple voltage

Frequency........c.ccceonnee. 510 26.4 VDC, 15 mA max.

Digital.......ccccoooiiieens 5t0 6.5 VDC, 15 mA max.

Auxiliary ......ccccceeeiienn. 9 to 24 VDC, 0.4A max

(only required for units with relays)
Reverse polarity and short circuit protected

Current output (4 to 20 mA)
Max Loop Resistance....300 Q

Loop Accuracy................ 32 pA max. error (25 °C @ 24 VDC)

Temp. drift.......c.coenneeeee. + 1 pA per °C max.

Power supply rejection ...+ 1 yA per V

Isolation: .........cccceeeiiis Low voltage < 48 VAC/DC from
electrodes and aux power

Maximum cable ............. 300 m (1000 ft)

Error condition................ 221 mA

Frequency output

Output modes................ Freq, Freq+10, or Mirror Relay 1

Max. Pullup Voltage....... 30 vDC

Max. Current Sink.......... 50 mA, current limited

Maximum cable ............. 300 m (1000 ft)

Reverse Polarity Protected to -40 V

Digital (S°L) Output

Serial ASCII, TTL level 9600 bps

Compatible with Signet 8900, 9900, 9950 and 0486 Profibus
Concentrator

Maximum cable ...... Application dependent (See 8900 manual)

Relay Specifications
Relay 1 and 2 Type........ Mechanical SPDT

Rating ......cccoooveviieeeen. 5A @ 30 VDC max.,
5A @ 250 VAC max.
Relay 3 Type......cccccouuen. Solid State
Rating......cccooveviieeene. 50 mA @ 30 VDC, 50 mA @ 42 VAC
Hysteresis.......ccccccceenee Adjustable, plus timer delay
Trigger Delay.................. Adjustable (0 to 9999.9 sec.)
Relay Modes.................. Off, Low, High, Window, and
Proportional Pulse
Relay Source................. Flow Rate, Resettable Totalizer
Error Condition .............. Selectable; Fail Open or Fail Closed
Display
Characters.........ccccco...... 2x16
Contrast.......cccceeveeeenen. User-set in four levels
Backlighting ................... Requires external 9-24 VDC,

0.4 mA max. (only on relay versions)

Environmental Requirements

Enclosure ........ccccceens NEMA 4X / IP65 (with cap installed)
Case ..covvviiiiei PBT
Display window.............. Polyamide
Storage Temperature.....-20 °C to 70 °C (-4 °F to 158 °F)
Relative Humidity........... 0 to 95% (non-condensing)
Operating Temperature:
Ambient.........cccocoeennne. -10 °C to 70 °C (14 °F to 158 °F)
Media .....cccooveieenieens 0 °C to 85 °C (32 °F to 185 °F)
Operating pressure:
Maximum ................... 10.3 bar @ 25 °C (150 psi @ 77 °F)

1.4 bar @ 85 °C (20 psi @ 185 °F)

(psi) (bar)
180 12.4

170 11.7
160 11.0
150 10.3
140 9.7
130 9.0
120 8.3

110 7.6
100 6.9 \
90 6.2
80 5.5 \
70 4.8
60 4.1 \
50 3.4
40 28 \
30 21

20 14
10 7

0
°C -20 0 20 40 60 80 100 120
°F -4 32 68 104 140 176 212 248

Standards and Approvals

+ CE

» UL/CUL (for display versions with relays)

* NSF (3-2551-P versions only)

* RoHS compliant
China RoHS (visit gfsignet.com for details)

* Manufactured under ISO 9001 for Quality, ISO 14001
for Environmental Management and OHSAS 18001 for
Occupational Health and Safety.

FC Declaration of Conformity according to FCC Part 15
This device complies with Part 15 of the FCC rules.
Operation is subject to the following two conditions:

(1) This device may not cause harmful interference, and,
(2) This device must accept any interference received,
including interference that may cause undesired operation.

+GF+
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Installation

Pipe fittings

Georg Fischer offers a wide selection of installation fittings
that control the position of the Magmeter electrodes in relation
to the dimensions of the pipe. You will find a complete list of
order numbers for installation fittings in the Calibration Tables
on pages 8, 9.

Type Description

Plastic tees Eﬂj * 0.5in. to 2 in. versions
:ﬂij:] « MPVC or CPVC

PVC Glue-on * 10in.and 12 in. only

Saddles » Cut 2% in. hole in pipe

» Weld in place using
solvent cement
PVC Clamp-on e 2in.to4in., cut 1-7/16
Saddles inch hole in pipe

&

6in.to 8in., cut 2-1/8 in.
hole in pipe

2in.to4in., cut 1-7/16
inch hole in pipe

Over 4 inch, cut 2-1/8 inch

Iron Strap-on
saddles

A

\(/ hole in pipe
» Special order 14 in. to
36 in.

0.5in. to 2 in. versions
Mounts on Threaded
pipe ends

2in.to4in., cut 1-7/16
inch hole in pipe

Over 4 inch, cut 2-1/8 inch
hole in pipe

Iron, Carbon Steel &
316 Stainless Steel
Threaded Tees

Carbon steel & Stainless
Steel Weld-on Weldolets

I

Fiberglass Tees

[

1.5in. to 2 in. PVDF insert

Union Fittings

and Wafers For pipes from

DN 15 mm to 50 mm
PP or PVDF

Location of Fitting

To ensure the fluid velocity profile is

Sensor Mounting Position

Horizontal pipe Runs

To minimize adverse effects of air pockets, sediment, or
excessive rotor wear (Paddlewheels), avoid mounting the flow
sensor at the top of the pipe (0°), bottom of pipe (180°), or the
sides (90°) from vertical.

Vertical Pipe Runs

Mount flow sensorsin any direction. To ensure pipe is flowing
full, with some back pressure, it's highly recommended the
fluid flow is upward.

Gravity and Discharge Lines
It's recommended to install a trap to ensure pipe is full during
flow conditions, and to minimize air pockets.

Vertical flow is ok
if the pipe remains
full at all times.

Fully Developed, without distortion
from piping system components,

please adhere to the recommended 2 x 90° Elbow

il
15 x1.D. |<5X_ID’|

2 x 90° Elbow
3 dimensions

Pump/Valve

straight run geometry.

(— 1]

—> [ [

_@ 25 x 1.D.
Selecting a Location

for accurate measurement.

being directed into the 2551 electronics housing.
and cause anomalies in the magmeter measurement.

injection point.

» The 2551 requires a full pipe and a fully developed turbulent flow profile

» In vertical installations, assemble the 2551 so the conduit ports are
facing downward. This prevents condensation inside the conduit from

» Chemical injection systems can temporarily alter the fluid conductivity

» To avoid this problem, install the magmeter UPSTREAM of the

]
M 40 x 1.D. |‘5X_HD’| ‘ 50 x I.D. |15X—IDF

Injection Point 9900

2551

N

Signet 2551 Display Magmeter
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Overview of Magmeter Display

2551 Display Magmeters use a dual-sided electronics
module and dual conduit ports. Unused ports must be
sealed to protect the electronics from water damage.

1. The lower set of conduit ports provide access to the
wiring terminals for:
* Loop Power
* Flow Output Signal (current loop, Digital (S3L),
frequency or Mirror Relay 1 output).

2. The upper set of conduit ports provide access to the
wiring terminals for:
* Relay output wiring
* Auxiliary power for relay coils and display backlight

3. The sensor is marked with a directional arrow to indicate
the direction identified as forward flow.
» An adhesive decal is also provided that can be affixed
to the pipe to indicate the direction of forward flow.
* Flow in the opposite direction from the arrow will be

4. The terminals in the magmeter are designed to
accomodate 16 to 22 AWG conductors.

5. The display includes two LEDs that light when
Relay 1 or Relay 2 are activated.
« All three relays can be monitored by scrolling to the
Relay Status display located in the View menu.
« If the Language option has not been made, new
magmeters will always open with the Select Language
display.

Language
English >

6. The part number, serial number and output type are
identified on the electronics module.

420 GPM
123456.78 >

Signet Magmeter

AV > e e
V+
v

Aux Pur]] Relay3 || Relay2 || Relay1

Relay output
Aux power

4 to 20 mA output
Digital (S3L) output
Frequency output
Mirror relay 1 output

identified as reverse flow on the display by a "-" symbol.

Wiring to Mirror Relay 1 Output

The 3-2551-21 and 3-2551-41 Magmeter can be configured
in the OPTIONS menu to provide an Open Collector output
in lieu of the sensor signal provided by Frequency or Digital
(S°L) output selections. The Open Collector output can be
programmed via the Relay 1 menu.

2551 Magmeter
|

‘ 4 Not used
- Ground

‘3
®:
[ K

Open Collector Out —»

<— 5-24 VDC

Wiring to Frequency Output

3-2551-21 and 3-2551-41 Magmeters may be programmed

in the OPTIONS menu to provide an open collector

FREQUENCY output.

* The maximum frequency output is 1000 Hz
(at 10 meters per second)

« If the Frequency + 10 output is selected, the maximum
frequency is 100 Hz (at 10 meters per second).

* AUX PWR must be connected to power the display
backlighting and to power the relay coils if included.

No1 Y
(NoZl - [
cl@ £
No2 O N
N2l &
c2cg ¢
NosEl T
2

&

%

ES

(\foxe] * |

- — — — — cno
o Auxiliary Power for: V+
|' Display backlighting V-
+ Relay Coils

VDC

|

I

1

T \

+
4.5-26.4

Ground ﬁ 4
() 3 |— -VDC =
Signal |\ g

Frequency Out
Frequency + 10 Out
(5t0 26.4 VDC)
Digital (S°L) Out
(4.5t0 6.5 VDC)

= +VDC =—

2551 Magmeter
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Wiring to 4 to 20 mA Output

4 to 20 mA loop output.

from -10 m/s to +10 m/s.

The 3-2551-22 and 3-2551-42 Magmeters provide a passive

» External loop power (24 VDC) is required.
» Factory standard calibration is 4 to 20 mA =0 to 5 m/s.
* The 4 to 20 mA output can be spanned to any range,

* AUX PWR must be connected to power the display
backlighting and to power to the relay coils if included.

Digital (S°L) output.

2551 Frequency or Digital (S3L)
Out to 9900 Transmitter

2551 Magmeter

Not used
Ground

NOT -
NC1 3
c1 €
NO2 N
NC2 z
c2 &
NO3 N
NC3 3
c3 £
™~ Alxiliary Power for V& |
| + Display backlighting Ve % |
~RelayCails _ _ _ _ " = — 4 4
8 _ ! — ' + I/ vDC
2>
©% 4-20 mA Loop Output
©
g ) + @ +VDC

2551 Magmeter

Wiring to Signet Instruments

The 3-2551-21 and 3-2551-41 Magmeter can be configured
in the OPTIONS menu to provide a Frequency or

Frequency and Digital (S°L) output can be used by Signet 8900
Multi-Parameter Controller, 9900 Transmitter, 9950 Dual Channel
Transmitter and 0486 Profibus Concentrator.

9900 Transmitter

+A
viva
aNo
aiHs

Frequency or (S°L)

+5 VDC

2551 Digital (S3L) Out to
9950 Dual Channel Transmitter

2551 Magmeter

Not used
Ground

Frequency or (S°L)

9950 S°L Inputs

DC POWER

+V
FREQ

DATA

+5VDC

GND

A\Y

Wiring to Signet Instruments

2551 Frequency Out to
8900 Controller

Not used

Ground

1/0 Module 3-8900.401-X
Frequeny  +9VDC (Black)

3.8900.621C
p—
—

‘"51"" Freq. Input (Red)
GND (Shield)

+5VDC (Black)
Input S3L (Red)
GND (White/Shield)

© ® < o o & o o -

3

BEEEE566H,

§ |
“Ee
2

2551 Digital (S°L) Out to
8900 Controller

Data
+5VDC
2551 Magmeter

Not used

0621C

1/0 Module 3-8900.401-X il

+5VDC (Black)
Freq. Input (Red)
GND (Shield)

+5VDC (Black)
Input S3L (Red)
GND (White/Shield)

3

5 o3 o o o o

2551 Digital (S°L) Out to

0486 Profibus Concentrator
0486 Profibus
Channel 1 -4

White

GND
DATA
Freq IN
+5V OUT

Ground

Data

+5VDC
2551 Magmeter

2551 Magmeter

Wiring to other manufacturer's Instruments

When using the 2551 in a system with other manufacturer's

equipment, a 10 KQ pull-up resistor (not supplied) may be

required to power the open collector output.

I Nosm™ 3~ T T

©
Auxiliary Power for: | NC3 g I
* Display backlighting c3 &
- Relay Coils | = — = = _I,
V+ H
= ¢ |
|~ == === |_ ST + 8
Non-Signet | ! — =
I Flow Instrument | | - &
| Ground @ ] e = Ground
Ground =

I Frequency Input * SeRepy

I s24vbcont @ | |
10KQ /I/
Pull-up Resistor |

| 2551 Magmeter

Frequency Out
5-24 VDC

6 Signet 2551 Display Magmeter
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Wiring Relays

Relay 1, Relay 2 Type: Mechanical SPDT NO1 .
Rating: 5A @ 30 VDC max., 5A @ 250 VAC max

Relays 1 and 2 are dry contact relays rated for 5 A maximum current.

They are best suited for switching high voltage loads, such as AC c1 . Mechanical Relays:

>
©
(o)
12
powered pumps and valves. — 5A@ 250 VAC
When used to switch inductive loads, the dry contact relays may be NO2 n o 5A @ 30 VDC
damaged by arcing. Signet recommends the installation of a filter >
device to prevent such damage. NC2 n =
3-8050.396 159 000 617 RC Filter kit (for relay use) 2 D o
Relay 3 Type: Solid State NO3 u ]
Rating: 50 mA @ 30 VDC, 50 mA @ 42 VAC C‘; Solid State Relay 3:
Relay 3 is a solid state relay. It can be applied exactly the same as a NC3 u &1 50 mAmax @ 30 VDC
dry cont_act relay, put the current rafting_ is 0.2 A (200 mA) maximum. & 50 mA max @ 42 VAC
Relay 3 is best suited to pulse applications and low voltage loads. C3 u
Auxiliary power must be connected to operate the relays and to Y+ . DE_ Auxiliary Power
power the display backlighting. Auxiliary power is fully isolated. ,_ . < | 91024 VDC
The Loop Power supply may be used for Aux power if the Z| 0.4 AMaximum

power source provides a sufficient current rating.

Relay Terminal Legend:
NO: Normally Open

NC: Normally Closed

C: Common

Application Notes: Relay Wiring

 Inductive relay loads may generate transient voltage spikes well in excess of the relay contact ratings. This will cause arcing across
the contacts and consequently rapid relay wear. Signet recommends an RC-style filter (“snubber”), installed as illustrated here.

» The filter kit (3-8050.396) is available as an accessory item. See ordering information on back cover.

» Signet product warranty does not cover damage to relays due to contact burnout.

3-8050.396
Definition: AC-powered: | NO1 .
An inductive load is an electrical device generally Pumps - .
made of wire that is coiled to create a magnetic field Alarm lamps C
; . Audio alarms
to produce mechanical work when energized. Mixers @] 120-240 VAC | C1 .

Examples of inductive loads include motors,
. no2 O
solenoids, and relays.

High voltage transients from these types of loads can NC2 n
cause arcing across mechanical switching contacts ) u
or can cause damage to solid-state contacts. c

+GF+ Signet 2551 Display Magmeter



Navigating the Menus

Normal Operation Display
The normal operating display shows the Flow Rate on the top line and the Resettable
Totalizer on the bottom line.

1234.56 GPM
» All menu instructions in this manual assume that the instrument is showing this display.

+GF+

RELAY1 @ @ RELAY2

Signet Magmeter

A YV » ENTER

2551 Menu Directory
The 2551 Magmeter uses seven main menus to provide access to the calibration and
programming features. Each menu serves a specific function.

A ENTER
Starting from the normal operating display, there are two ways to access the menus:
1. Press the A key to scroll to the Enter Menu display, then press the » key. Enter Menu
2. Pressthe ENTER key and hold it for about three seconds. =2 Q 3s
>
Setup Menu
This menu contains all of the settings and information that the magmeter requires to operate, Enter Menu
including the K-Factor, the totalizer settings, low flow cutoff, and several display characteristics. Setup >
See page 10 for details related to this menu. vV A
Calibration Menu Enter Menu
This menu provides two different methods for adjusting the calibration. See page 14 for details Calibration >
related to this menu.
v A
Relay Menus Enter Menu
Each of the available relays in the 3-2551-21 and 3-2551-22 are programmed from their own Relay 1 >
dedicated menu. See page 15 for details related to these menus. \V} A
NOTE: Menu items associated with Relays 2 and 3 are suppressed in models without relays. Enter Menu
Relay 2 >
V A
Enter Menu
Relay 3 >
Test Menu V A
This menu is used to manually toggle relays or to induce a known value out of the 4 to 20 mA Enter Menu
terminals. See page 17 for details related to this menu. Test >
Options Menu v A
This menu contains those settings and values that are usually programmed during the initial Enter Menu
installation, and then seldom modified, including the SECURITY CODE (see section below). Options >

See page 17 for details related to the Options menu.

Keypad Functions Security Code

The 2551 has a security code that can be programmed to any

four-digit numerical value.

» The factory setting is 0-0-0-0.

» To program the security code go to the Options menu.

» The security code will be required to edit any of the items in
the menus. It is required only once for each editing session.

» Record the custom security code here or in a safe location.

« If the security code is lost, contact your Signet service
center for instructions.

Scrolls UP through any menu.
A If the display shows any flashing character or selection,
scrolls UP to the previous value or selection.

Scrolls DOWN through any menu.
v If the display shows any flashing character or selection,
scrolls DOWN to the next value or selection.

Av Press the A and V¥ keys together to abandon any
unsaved edits and return to the previous display. Enter'Gode

Opens the menu currently being displayed. QVEOO
[> In Edit modes, advances the flashing character.

In menus with only two options (Yes or No, On or Off)
toggles between selections.

Saves a new selection in any menu. A Security Code
ENTER| From Normal Operation display, jumps to first selection

in Menu directory (when held for three seconds)

8 Signet 2551 Display Magmeter +GF+



View Menu

Shows the current output. For 4 to 20 mA Output models only.

This display is a reminder to visit the Signet website for updates

The VIEW menu contains all of the basic information available from the Magmeter.

» The normal operating display shows the FLOW RATE on the top line of the display
and the Resettable Totalizer on the lower line of the display.

current display. In this display it points the way to the TOTALIZER RESET function.
See below for detailed instructions.

» With AUXILIARY power connected to the magmeters with Relays, the display will be
backlit. There is no switch to turn the backlight off.

A flashing character or text on the display indicates that the item is being edited.
This manual uses a (red) star to illustrate a flashing display.

» The following information is viewed by scrolling A or Y. These displays will remain in
the display for 10 minutes, then the normal operating display will return.

Show the permanent total. This totalizer cannot be reset.

Relay States shown for units with a relay board.

and information about Signet products.

+GF+

RELAY1 @ @ RELAY?2

1234.56 GPM
876543.21 >

Signet Magmeter

A V » ENTER

Enter menus from this display. See page 10 for details.

Resetting the Resettable Totalizer

1234.56 GPM
876543.21 >

Enter Code
0600

P
<

Reset Total, ?
Yes N

L |

123456.78 GPM
000000.00 >

+GF+

» The Right Prompt symbol (>) always indicates a sub-menu associated with the RELAY 1 @ ® RELAY2

1234.56 GPM
876543.21 >

Signet Magmeter

A A p ENTER

vV A
Gallons
Perm 876543.21
\ A
Current Output
14.89 mA
\ A
Relay 1 2 &
Off Off Off
\ A
Web Site
www.gfsignet.com
\Y A
Enter Menu
>

From the normal operating display, press the » key.

The resettable totalizer can be configured to require
the security code before allowing the reset. If the
Total Reset is set to "RESET OFF" this display will not
appear. See page 17, Options Menu for instructions.

Press any arrow key to toggle the flashing selection
from NO to YES.

Press the ENTER key. The totalizer will reset to all
zeroes and the display will immediately return to the
normal operating display.

+GF+
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The Setup menu contains all of the parameters necessary for the 2551 Magmeter to begin
measuring flow.

NOTE: The Security Code must be entered before any changes can be made to the Setup menu.

See page 17 for details related to the Options menu..

Enter Code
00

v

Use the keypad to navigate through each setting.

+GF+

RELAY1 @ @ RELAY2

Enter Menu
Setup

Signet Magmeter

A A p ENTER

AV D> ener The values shown for each menu item represent
the factory standard setting. All 2551 magmeters
O O O O are packaged with these settings.

K-Factor: See the charts on pages 12-13 for values in pulses per U.S. gallon or in pulses per liter. K-Factor
To use other units, convert the published values as appropriate. 060.000 S
Pipe Size: Select the pipe size that is nearest to the nominal pipe size. Pipe Size

2” DN50 >

Flow Units: Set the units for the application. Four characters are available. The first three characters can be set to any symbol or alpha
character, upper or lower case. The following special symbols are located between the upper case and lower case menus:

* (centered dot) M (micro) _ (blank) Fl Unit
. . Oow units
- (dash / (slash 3 (for cubic units
(dash) (slash) ( ) e .
The last character selects the timebase for the flow rate measurement.
Select S/s (seconds) M/m (minutes), H/h (hours) or D/d (days)
Set 4 mA: (2551-22 and -42 versions only) Set the flow rate where the current output will be 4 mA. Set 4 mA
-100 GPM >
Set 20 mA: (2551-22 and -42 versions only) Set the flow rate where the current output will be 20 mA.
Set 20 mA

The 4 to 20 mA output may be spanned to monitor forward and reverse flow rates.

100.00 GPM >

Total Factor: Set the factor by which the totalizer will count. This setting is made in the application
units (i.e., gallons, liters, etc.)

Total Factor
1000.0 >

Totalizer Units: Set the Totalizer Units. This setting serves as a label for the totalizer displays only.
It has no effect on the measurement. The special characters listed in the Total Factor settings are

Totalizer Units

available here also. Gallons -
Low Flow Cutoff: Set a flow rate that the 2551 Magmeter will use as a minimum threshhold. Low Flow Cutoff

If the flow rate falls below this value, the 2551 will respond as if the flow were zero. 0.5 GPM >
Averaging: Set the averaging period based on the installation and flow conditions. Smaller values NaERl

allow the 2551 to respond to changes in flow rate quickly, while larger values smooth the fluctuations ging

caused by installation and flow conditions. See page 11 for details. 25 secs .
Sensitivity: Set a percentage of maximum range by which the flow must change to override the Sensitivity
averaging feature and "jump" quickly to the new flow rate. See detailed explanation on page 11. 100% >

10
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Averaging and Sensitivity

Even the most carefully engineered flow systems may
experience erratic and unstable conditions. If the instability is
communicated to the output functions, the results may create
problems for control devices.

To alleviate these issues, the 2551 provides two adjustments
that operate in tandem. The information here will help

in determining the appropriate settings for any specific
application.

Averaging

* The AVERAGING setting dictates the time over which the
magmeter will average the flow signal.
The LCD display is updated every second. With averaging
at 14 seconds, the flow rate on the display is an average of
the previous 14 seconds input.

Short averaging times provide the fastest display and output
response to changes in the flow rate.

Higher averaging times help to smooth the display and
current output where the flow in the pipe is erratic or
unstable due to installation limitations.

Sensitivity

* The SENSITIVITY setting determines how the 2551
responds to sudden surges in the flow rate. It "overrides"
the Averaging function just long enough to allow an actual
change in flow rate to be displayed, then resumes the
averaging. The result is a smooth flow display and a quick
response to large shifts in the flow rate.

The settings for Sensitivity represent a percentage of the

Example: A sensitivity setting of 25% means that the flow
rate must change instantly and by more than 2.5 ms before
the function is enabled.

NOTE: The SENSITIVITY function is ineffective if the
AVERAGING function is set to zero.

A CAUTION

The SENSITIVITY function changes the
response characteristics of the magmeter.

If used as part of a tuned closed loop control
system, such a change may be undesirable.

magmeter's maximum range, or 10 meters per second (m/s).

No Averaging

With AVERAGING set to zero, the flow rate will be displayed
immediately and with no filtering. This line represents the
actual output of the flow sensor as it responds to unstable flow

conditions in the pipe.

. .
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Time 10s 20s  30s 40s 50s 60s  70s

Averaging Only

With AVERAGING set to 50 seconds and SENSITIVITY still
set to zero the flow rate is stabilized, but a sharp change in
flow rate is not represented on the display or at the output for

50 seconds or longer.

|||||||||||||

Velocity

.........

Averaging and Sensitivity
With AVERAGING at 50 seconds and SENSITIVITY set to
25%, the flow rate is stabilized, while the sudden shift in flow

is reflected very quickly.

Velocity

Time 10s  20s  30s  40s  50s  60s  70s
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Bi-Directional Flow

» The 2551 magmeter is designed to measure bi-directional flow.
» The forward flow direction is indicated by the directional arrow molded into the side of the 2551 sensor.

» The conduit ports are assembled at the factory to point UPSTREAM. They may be reversed by
disassembling the components of the magmeter and reassembling.

! N
O O

DT) oy

Flow Rate Display

The "+" sign is suppressed during forward flow.
"-123.45 GPM" during reverse flow.

Totalizer Display

The totalizer will count during forward flow conditions only.
During reverse flow the totalizer will not increment.

Relay Outputs

May be set to detect reverse flow: "Low Setpoint at -25 GPM."

4 to 20 mA output

May be scaled to span any flow range:
For example: "4 to 20 mA =-100 GPM to +100 GPM"

Frequency output, Frequency + 10 output

Reverse flow is processed same as forward flow in the frequency output magmeters.

Digital (S°L) output

Reverse flow results in 0 flow rate output.

Calibration Data: K-Factors

Polypropylene True Union Tees
and Wafers

PVDF True Union Tees,

PVC True Union Tees

PVC Tees and Clamp-on Saddles Eﬂj

Pipe Size Fitting | K-Factor | K-Factor Pipe Size Fitting K-Factor | K-Factor
(Metric) Type Gallons Liters (In.) Type Gallons Liters
POLYPROPYLENE FITTINGS (DIN/ISO, BS, ANSI) SCH 1/80 PVC-'\lA’PT\fsET%(';SOR 302"'278700""’5 S——

2 . .
DN15 PPMTO005 |2192.73 579.32 Y MPVSTO07 1407 6 37190
DN25 PPMTO010 |737.16 194.76 14 MPV8T012 464 .91 122.83
DN32  PPMTO12  453.46 119.81 17 MPV8T015 331.43 87.56
2 MPV8T020 192.89 50.96
DN40 PPMT015 |275.03 72.66 SCH 80 PVC TEES FOR SCH 80 PIPE
DN50 PPMTO020 164.17 43.35 A PV8T025 131.46 34.73
PVDF FITTINGS (DIN/ISO, BS, ANSI) 3 PV8T030 82.52 21.80
DN15 SFMTO005 1946.49 514.26 4 PV8T040 44,78 11.83
DN20 SFMT007 1158.05 305.96 SCH 80 CPVC TEES FOR SCH 80 PIPE
Yo MCPV8T005 2277.0 601.58
DN25 SFMTO10 | 749.09 197.91 % MCPV8T007 1407.6 371.90
DN32 SFMT012 | 439.51 116.12 1 MCPV8T010 861.17 22752
DN40 SFMTO015 | 248.93 65.77 1Y MCPV8T012 464.91 122.83
2 MCPV8T020 192.89 50.96
PVE;:';TINGz\sI;AI_II:I(;IoiO, BZSO’6¢N72I) 546.30 SCH 80 PVC CLAMP-ON SADDLES FOR SCH 80 PIPE
: : 2 PV8S020 193.83 51.21
DN20 PVMTO007 | 1136.61 300.29 2V PV8S025 138.01 36.46
DN25 PVMTO010 | 716.52 189.31 3 PV8S030 83.89 22.16
DN32 | PVMTO012 | 446.07 117.85 g mggggg gg-gg ;oégo
DN40  PVMTO15 278.83 73.67 3 PV8S080 12 52 3.31
DN50 PVMTO020 159.36 42.10 10 PV8S100 7.94 2.10
12 PV8S120 5.71 1.51
SCH 80 PVC CLAMP-ON SADDLES FOR SCH 40 PIPE
2 PV8S020 180.01 47 .56
2 PV8S025 123.72 32.69
3 PV8S030 75.81 20.03
4 PV8S040 41.87 11.06
6 PV8S060 19.71 5.21
8 PV8S080 11.73 3.10
10 PV8S100 7.43 1.96
12 PV8S120 5.23 1.38

12 Signet 2551 Display Magmeter
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Calibration Data: K-Factors

Carbon Steel Tees and Weld-o-Lets
Stainless Steel Tees and Weld-o-Lets
Galvanized Iron Tees

Bronze and Copper Tees and Brazolets

K-Factor

Pipe Size Fitting K-Factor Pipe Size Fitting K-Factor K-Factor
(In.) Type Gallons Liters (In.) Type Gallons Liters
CARBON STEEL TEES ON SCH 40 PIPE BRONZE TEES ON SCH 40 PIPE
Yo CS4T005 1572.66 415.50 1 BR4T010 582.34 153.86
Y2 CS4T007 1086.73 287.11 1 BR4T012 330.54 87.33
! CS4T010 | 582.34 153.86 1%  BRATO15 | 254.76 67.31
11A CS4T012  377.48 99.73 5 BRATO20 | 157 36 4158
1% | CS4TO15 | 267.79 70.75 COPPER TEES FITTING ON COPPER PIPE SCH K
2 CS4T020 | 167.85 4435 ” CUKT005 | 2459 19 649,72
STAINLESS STEEL TEES ON SCH 40 PIPE o CUKT00r T 1108.02 00074
Y CRAT005 | 1601.26  423.05 - -
Y% CR4T007  937.78 24776 1 CUKTO10 | 649.87 171.70
1 CR4TO10 60618 160.15 1% | CUKTO012 | 422.03 111.50
1% CR4T012 | 279.68 73.89 1% | CUKTO15 | 281.43 74.35
1% CR4TO15 | 147.65 39.01 2 CUKT020 | 136.02 35.94
2 CR4T020 | 111.90 29.56 COPPER TEES FITTING ON COPPER PIPE SCH L
STAINLESS STEEL WELDOLETS ON SCH 40 PIPE A CUKTO005 | 2406.30 635.75
2% CR4W025 | 106.31 28.09 % CUKT007 | 1174.77 310.37
3 CR4W030 | 72.27 19.09 1 CUKTO010 | 672.28 177.62
4 CR4W040 | 36.84 9.73 1V CUKTO012 | 402.84 106.43
S CR4W050 | 29.28 7.73 1% CUKT015 | 294.99 77.94
6 CR4W060 | 20.29 ©.36 2 CUKT020  149.63 39.53
8 CRAW080 | 11.73 3.10 COPPER/BRONZE BRAZOLET ON SCH 40 PIPE
10 |CRAWI00 |7.45 1.97 2% | BR4B025 | 117.31 30.99
12 CR4W120 5.24 1.39 3 BRAB030 | 78.62 2077
CARBON STEEL WELDOLETS ON SCH 40 PIPE : :
2% | CS4W025 | 105.70 27.93 4 | BRA4B040 | 45.13 11.92
3 CSAW030 | 70.68 1867 5 BR4B050 | 32.79 8.66
4 CS4W040 | 36.38 9.61 6 |BRA4BO60 |2273 6.01
5 CS4W050 | 29.28 7.73 8 BR4B080  13.14 3.47
6 CS4W060 | 20.29 5.36 10 BR4B100 | 8.34 2.20
8 CS4W080 | 11.73 3.10 12 BR4B120 | 5.87 1.55
10 CS4W100 | 7.45 1.97
12 CS4W120  5.24 1.39 Iron Saddles
GALVANIZED IRON TEES ON SCH 40 PIPE
1 IR4T010 558.50 147.56 Pipe Size Fitting K-Factor K-Factor
1% IR4T012 334.45 88.36 (In.) Type Gallons Liters
1% IR4TO15 | 248.97 65.78
2 IR4T020 146.00 38.57 SCH 80 IRON SADDLE ON SCH 80 PIPE
2 IR8S020  194.85 51.48
2% | IR8S025 | 142.28 37.59
3 IR8S030 | 87.53 23.13
4 IR8S040  40.62 10.73
5 IR8S050 | 29.28 7.74
6 IR8S060 | 22.30 5.89
8 IR8S080  12.52 3.31
10 IR8S100 | 7.94 2.10
12 IR8S120 | 5.65 1.49
SCH 80 IRON SADDLE ON SCH 40 PIPE
2 IR8S020  185.35 48.97
2% | IR8S025 | 127.47 33.68
3 IR8S030 | 76.62 20.24
4 IR8S040  40.23 10.63
5 IR8S050 | 27.32 7.22
6 IR8S060 | 19.71 5.21
8 IR8S080 | 11.61 3.07
10 IR8S100 | 7.36 1.94
12 IR8S120 | 5.18 1.37
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Calibration Menu

The K-Factors published in this manual assume that the flow conditions in the pipe are ideal.

+GF+

Many factors that affect the flow rate are beyond the control of the magmeter; variations in actual REATT @ @ revvz

1234.56 GPM
876543.21 >

pipe dimensions, pipe smoothness, and other flow conditions will contribute to the total system error.

Performing a custom calibration with the magmeter in place will adjust the K-Factor and can serve

to compensate for installation conditions that may be less than ideal. Signet Magmeter

Select one of the calibration methods in this menu to achieve the most accurate measurement AV > o
possible in a specific application.

A ENTER
NOTE: The Security Code must be entered Enter Menu
before selecting the calibration method. > Q
3s
Enter€ode -
0000 Enter Menu
[ S| Setup >
V A
Enter Menu
Calibration >

Volume Method of Calibration

Use the volume method of calibration if the fluid passing the magmeter can be measured by a volumetric method (as in a vessel of
known volume, or by weight). It requires the ability to pump a known volume of water past the magmeter, and then input the volume
into the 2551 program. It is most useful for small pipes and lower flow rates.

When performed properly, volumetric calibration is the most accurate method. For best results a five minute test period is
recommended, and the test period should be no less than two minutes.

Press Enter

At START, the 2551 begins counting the flow past the sensor.
To Start

Press Enter

At STOP, the 2551 stores the total flow accumulated since the START.
To Stop

Enter Volume

000000. GPM

Enter the VOLUME that has been pumped past the sensor.

Value must be
more than 0.0

This error message appears if volume entered or the accumulated flow is zero.
Repeat the test after checking the system.

K-Factor
Out of Range

This message appears if the new K-Factor is less than 0.0001 or greater than 999999.
To correct the problem, perform the volumetric flow again, and be certain that the

K-Factor
45.6789

volume entered is accurate.

Using the information from the VOLUME method, the 2551 will recalculate a new K-Factor.
Press ENTER to accept the new value, or use the keypad to adjust the value.

Rate Method of Calibration

Use this method if the 2551 Magmeter must be calibrated to match a reference flow meter. This is the method most commonly used
by monitoring agencies, and for large pipes where volumetric calibration is impractical. The accuracy of this calibration method is
largely dependent on the accuracy of the reference meter and the proximity of the reference to the Signet 2551 Magmeter.

The flow rate shown is based on the existing calibration of the 2551. Use the keypad to modify

Set New Flowrate the flow rate to match the reference meter. The 2551 will automatically calculate a new K-Factor

45.6789 based on the new flow rate.
K-Factor This message appears if the new K-Factor is less than 0.0001 or greater than 999999.
Out of Range To correct the problem, reexamine the flow rate and make certain it is accurate.
K-Factor Using the information from the RATE MATCHING method, the 2551 will recalculate a new K-Factor.
56.7890 Press ENTER to accept the new value, or use the keypad to adjust the value.

14 Signet 2551 Display Magmeter +GF+



Relay Menus

State relay (Relay 3).

Magmeter models 3-2551-21 and -22 have two dry contact relays (Relays 1 and 2) and one Solid

Any of these relays can be set to any of the operating modes listed below.

The setpoint values for HIGH, LOW and WINDOW modes can be set to negative values if required.
For example, a LOW alarm might be set to activate if the flow rate falls below -10 GPM.

Negative values are not available for relays in PULSE or TOTAL modes.

Off: If a relay is not used, it can be turned Off to prevent contact wear.

+GF+

RELAY 1 @

1234.56 GPM
876543.21 >

® RELAY2

Signet Magmeter

A Y

A

NOTE: The Security Code must be entered

before modifying the relay menu.

Enter€ode
0000

e\

Enter Menu

Pulse Relay Mode

Program a relay to activate for a fixed period, for each volume of fluid that passes the sensor.

Relay 1 Mode Relay 1 Volume
Pulse > 0.0000 Gal >
Relay 1 Width
0.1 secs >

Total Relay Mode

Program a relay to activate when the Resettable totalizer reaches a specific value. The maximum setting is 999999.

» ENTER

A ENTER
ol
> S
Enter Menu
Setup >
\ A
Enter Menu
Calibration >
\ A
Enter Menu
Relay 1 >

For example, program the relay to pulse once for 100 ms for every 3 gallons that pass by the sensor.

Relay Volume: Set the volume of fluid that the 2551 must
measure before activating the relay for one pulse.

Pulse Width: Adjust the length of time the relay will remain
activated. The pulse width setting is dependent on the type of
external equipment being connected to the relay.

When the totalizer is reset, the relay will be deactivated and the process begins anew.

Relay 1 Mode
Total >

Relay 1 Set High
000000

Application example: A filter must be replaced in an R.O. system every 10000 gallons. The service representative that installs
a new filter sets relay 3 to Total mode, sets the setpoint at 10000 and resets the totalizer to 000000.00. Every time the Totalizer
reaches 10000, the relay activates and lights a message indicator to remind the service representative to replace the filter.

+GF+
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High, Low, or Window Relay Modes

Program the relay to activate when the flow rate reaches a setpoint (High or Low) or when the flow
rate moves outside of a prescribed range (Window).

Reverse Flow
The setpoint values for HIGH, LOW and WINDOW modes can be set to negative values if required.
For example, a LOW alarm might be set to activate if the flow rate falls to -10 GPM.

Process

Hysteresis - 4

+GF+

RELAY 1 @

1234.56 GPM
876543.21 >

® RELAY2

Signet Magmeter

A Y » ENTER

Relay behavior with LOW Setpoint

Low Setpoint -

Enter Menu

> Time

Process

High Setpoint
Relay behavior with HIGH Setpoint

Hysteresis - - ====-=-=-[====--====3-------

> Time

A ENTER
o] o] Q@ \
> S
Enter Menu
Setup >
\ A
Enter Menu
Calibration >
\ A
Enter Menu
Relay 1 >

NOTE: The Security Code

High Limit 1 - - ot = = = = =55 T~ tarasic ~ A must be entered before
""""""""""" modifying the relay menu.
Relay behavior with WINDOW Setpoints
---------------------- ) Enter€ode
Low Limit = === === ====ouu-Nooo -,g-l-ﬂxsmes's 0000
~R%- o |
> Time
Relay activated Z3 The values shown for each menu item represent the factory standard
Relay deactivated B setting. All 2551 magmeters are packaged with these settings.
Set Low:
. . Relay 1 Set L.
Set the flow rate where a Low relay will be activated. Rela{lv'f ode > %:_%00 ?;p“:w >
Hysteresis: Relay 1 Hys
Set a flow rate increment where the relay will be deactivated. Lty Sl >
The hysteresis setting serves to prevent relay "chatter" when Relay 1 Delay
the flow rate recovers from an alarm condition by requiring the 0.1 secs >
low rate to move substantially within the setpoint.
iah: Relay 1 Mode Relay 1 Set High
Set High: _ _ . High > 00.000 GPM >
Set the flow rate where a High relay will be activated.
Relay 1 Hys
00.000 GPM >
Delay:
Set a time period for the relay to wait after reaching the setpoint. Relay 1 Delay
This delay serves to prevent the relay "chatter" by allowing the 0.1 secs >
flow rate time to move back within the setpoint.
Relay 1 Mode Relay 1 Set Low
Window > 00.000 GPM >
Relay 1 Set High
00.000 GPM >
Relay 1 Hys
00.000 GPM >
The menu repeats for Relay 2 and Relay 3. Relay 1 Delay
0.1 secs >
16 Signet 2551 Display Magmeter +GF+




Test Menus

2551 to activate the relays

+GF+

RELAY 1 @ @ RELAY 2

Enter Menu
Test >

Signet Magmeter

A VY » ENTER

Options Menus

+GF+

RELAY1 @ @ RELAY2

Enter Menu
Options

Signet Magmeter

A Y » ENTER

The values shown for each
menu item represent the
factory standard setting.
All 2551 magmeters are

Output Modes

Test Output
4.20 mA >
Test Relay 1
Open Closed >
Test Relay 2
Open Closed >
Test Relay 3
Open Closed >

Language
English

Security Code

*kkk

Contrast
2

Total Reset
Lock On

Noise Rejection
60 Hz

packaged with these settings.

Flow Decimal

*kkk k%
.

Total Decimal

Fkkkkk k%

Separator
ddd.d >
Output Mode
Frequency >

The Test menu provides a simple method to verify that the system is operating properly. Auxiliary power MUST be connected to the

Shown for 4 to 20 mA models only (3-2551-XX-22, -42).
Use the keypad to enter any current output from 4.0 mA
minimum to 22.1 mA maximum.

Shown for Relay models Only
Toggle any of these relays ON and OFF to verify that the
system is operating properly.

Aucxiliary power MUST be v+ @ Ausxiliary Power
connected to the 2551 to v . 9to 24 VDC
test the relays. h 0.4 A Maximum

The Options Menu contains those features and settings that will normally be set one time and then seldom changed. These include
language preference, decimal placement, Security Code assignment, etc.

Select from English, French, German, Italian, Portuguese or
Spanish. This selection will be displayed at first power-up of a
new magmeter.

Security Code can be set to any four digit number.
Factory standard setting is 0000.

Set for best view after the magmeter is installed.
Larger number means display appears darker.

Lock ON requires the Security Code before resetting the
Resetable Totalizer. Lock OFF reset with no security code.

Filters out common 50 or 60 Hz electrical noise.

Set the maximum resolution for the FLOW RATE display by
limiting the decimal to this point. The Flow Rate display will
auto-scale from this resolution up to whole units.

Set the maximum resolution for the TOTALIZER display by
limiting the decimal to this point. The Totalizer display will
always show this resolution.

Select decimal point or comma for use in numeric displays.

For Frequency/Digital models only: Select Freq output,
Freq + 10 output, Mirror Relay 1 output or (S°L) Digital output.

In FREQUENCY output mode, the 2551 serves as a traditional flow sensor and provides an output pulse that is compatible
with all Signet POWERED flow instruments. It is not compatible with the 5090 Self-Powered Flow Meter or the 8150-1 Battery-
Powered Flow Totalizer. The frequency output range is from 0 Hz to 1000 Hz.

The FREQUENCY + 10 output mode reduces the output frequency of the 2551 to a range that is useful for some programmable
logic controllers (PLC). The frequency output range is from 0 Hz to 100 Hz. This shift does not affect the stated accuracy of the
2551 Magmeter's frequency output.

The MIRROR RELAY 1 output mode allows 2551 Frequency/Digital models to use the Open Collector Output like a relay that can
be programmed via the Relay 1 menu. If the magmeter is equipped with relays, this mode will mirror the settings of Relay 1.
If the magmeter is not equipped with relays, this mode can still be selected and programmed via the Relay 1 menu.

The (S°L) Digital output mode switches the 2551 to the Signet serial data output called (S°L) (Signet Serial Sensor Link).
In this mode the 2551 can be added to the serial bus of the Signet 8900 Multi-Parameter Controller or 9900 Transmitter.

+GF+
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Precalibration conditioning: The magmeter may appear to be unstable immediately after installation. Allow the sensor to sit in a full
pipe for 24 hours before beginning calibration and operation.

» Use a cable gland or a liquid tight connector to seal the cable ports from water intrusion.

» Use PTFE tape or a suitable sealant on cable ports.

» The 2551 magmeter must be carefully grounded to eliminate electrical noise that may interfere with the measurement.

» Grounding requirements will vary with each installation.

» The following recommendations should be applied in sequence until the interference is eliminated.

(D The ground terminal on the outside of the yellow housing is connected internally to the grounding ring at the tip of the sensor.
Connect a conductor (14 AWG/1.5 mm?2wire recommended) from this terminal directly to Earth ground to prevent electrical
noise from interfering with the magmeter signal.

If the interference persists, apply step #2:

@ Connect grounding rings, metal clamps or grounding electrodes to the pipe immediately upstream and downstream of the
magmeter sensor location. These devices must be in contact with the fluid.

If the interference persists, apply step #3:

(® The shield from the output cable must be terminated at the remote instrument ONLY.
This shield must not be connected at both ends!

If the interference persists, apply step #4:
@ Connect an additional wire (minimum AWG 14/1.5 mm2) from the remote instrument ground to the magmeter ground terminal.

{ )
100N

Do not terminate

@ shield at Magmeter
,e------'/ — | 7 (1)
Instrument f—t=—t -

______ —1 | b T
= i

= V i
—=>
Sensor | b—
Grounding ring —
\A -
4in. to 50 in. 4in. to 50 in.
R «—
(10 cmto 1.3 m) (10 cmto 1.3 m)

Grounding rings on plastic pipe
@ (Install between flanges) @

metal straps on metal pipe

Maintenance

The 2551 Magmeter requires very little maintenance. There are no user-serviceable components in the magmeter.

« If the fluid contains deposits and solids that may coat the electrodes, a regular cleaning regimen is recommended.
» Do not use abrasive materials on the metal electrodes. Clean with soft cloth and mild detergent only.
» Use a cotton swab and mild detergent to remove deposits on the metal electrodes.

Environmental Recommendations:
* When used properly, this product presents no inherent danger to the environment.
» Please follow local ordinance when disposing of this or any product with electronic components.
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Troubleshooting

Symptom

Possible Cause

Solution

Output is erratic and unstable.

Magmeter installed too close to upstream
obstruction.

Relocate the magmeter to have straight
uninterrupted pipe upstream of the sensor
for at least 10 x the pipe diameter.

Magmeter located in area exposed to air
bubbles/pockets.

Eliminate air bubbles in the pipe.

Magmeter is installed in pipe backwards.

Remove the magmeter and reinstall with
the flow direction arrow on the sensor body
pointed DOWNSTREAM.

Electrical noise is interfering with the
measurement.

Review the grounding of the magmeter and
the pipe. Install adequate Earth ground to
allow the Magmeter to operate properly.

Electrodes are coated with deposits or
chemical oxide layers.

Carefully clean the electrodes. Refer to
sensor manual for details.

Output is not 0 when flow is stopped.

Electrodes not adequately conditioned in
fluid.

Allow the sensor to sit in full pipe for
24 hours then restart.

Fluid is moving inside the pipe.

Increase the Low Flow Cutoff. (page 10)

No 4 to 20 mA output.

Loop power not connected correctly.

Connect 24 VDC +10% connected to loop
terminals 1 and 3.

4 to 20 mA current output is incorrect.

4 to 20 mAis not scaled properly.

Check and reset in the Setup Menu.

No Frequency output.
No (S3L) output.

2551 is wrong model.

Frequency / (S°L) model:
3-2551-21 (w/rlys) or -41 (w/o rlys).

Incorrect setting in Options Menu.

Select Frequency in the Options menu.

Wiring is not correct.

Check wiring, make corrections.

Frequency input to other manufacturer's
flow instrument does not have pull-up
resistor.

Install 10 kQ resistor. (page 6)

No flow rate, current output is 22 mA.

The fluid is too clean for Magmeter.

Unsuitable application for Magmeter.

Electronic component failure.

Return 2551 to factory.

Blank display, no backlighting, no relay
LEDs, but external equipment using
output signal is still working.

2551 AUX power is not connected.

Connect AUX power (page 7)
(9 to 24 VDC, 0.4 A max.)

Error Message:
"Error Not Saved"

Main power is below specification.

Correct the main power deficiency.

Reverse flow:

Empty Pipe Detection

Troubleshooting with the RED and BLUE LEDs

No Lights: The power is off or the sensor is not connected

Solid Blue: The power is on but there is no flow in the pipe.

Blinking Blue: Normal operation, blink rate is proportional to the flow rate.
Alternating Red-Blue: Empty pipe indication (electrodes are not wet.)
Blinking Red: System errors (Electrical noise interference)

Solid Red: Instrument error (defective electronic component)

» Frequency output will be locked to 0 Hz if electrodes are not wet.
« Digital (SL) output will be locked to 0 if electrodes are not wet.

* 4 to 20 mA will be locked to 4 mA if electrodes are not wet.

* Blue and Red LED indicators on the magmeter circuit will blink alternately if the electrodes are not wet.

-

~ %ﬁ

» Frequency out cannot distinguish reverse flow from forward flow. The output will be the absolute value.
« Digital (SL) output: Reverse flow results in O flow rate displayed on 8900, or with negative numbers on the 9900.
* 4 to 20 mA output can be spanned into negative flow range using the 3-0252 Configuration Tool.

(example: 4 to 20 mA =-100 to +100 GPM).

+GF+
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Ordering Information

Frequency or Digitial (S°L) output

Mfr. Part No.
3-2551-P0-21
3-2551-T0-21
3-2551-V0-21
3-2551-P0-41
3-2551-T0-41
3-2551-V0-41
3-2551-P1-21
3-2551-T1-21
3-2551-V1-21
3-2551-P1-41
3-2551-T1-41
3-2551-V1-41
3-2551-P2-21
3-2551-T2-21
3-2551-V2-21
3-2551-P2-41
3-2551-T2-41
3-2551-V2-41

Code

159 001 267
159 001 436
159 001 269
159 001 261
159 001 433
159 001 263
159 001 268
159 001 437
159 001 270
159 001 262
159 001 434
159 001 264
159 001 435
159 001 454
159 001 456
159 001 432
159 001 460
159 001 462

4 to 20 mA output

Mfr. Part No.
3-2551-P0-22
3-2551-T0-22
3-2551-V0-22
3-2551-P0-42
3-2551-T0-42
3-2551-V0-42
3-2551-P1-22
3-2551-T1-22
3-2551-V1-22
3-2551-P1-42
3-2551-T1-42
3-2551-V1-42
3-2551-P2-22
3-2551-T2-22
3-2551-V2-22
3-2551-P2-42
3-2551-T2-42
3-2551-V2-42

Code

159 001 273
159 001 439
159 001 275
159 001 279
159 001 442
159 001 281
159 001 274
159 001 440
159 001 276
159 001 280
159 001 443
159 001 282
159 001 438
159 001 455
159 001 457
159 001 441
159 001 461
159 001 463

Description

DN15 to DN100 (%2 in. to 4 in.) Polypropylene and 316L SS. Two SPDT relays, one solid state relay
DN15 to DN100 (*zin. to 4 in.) PVDF and Titanium. Two SPDT relays, one solid state relay

DN15 to DN100 (%2 in. to 4 in.) PVDF and Hastelloy-C. Two SPDT relays, one solid state relay
DN15 to DN100 (%2 in. to 4 in.) Polypropylene and 316L SS.

DN15 to DN100 (%2 in. to 4 in.) PVDF and Titanium

DN15 to DN100 (*zin. to 4 in.) PVDF and Hastelloy-C

DN125 to DN200 (5 in. to 8 in.) Polypropylene and 316L SS. Two SPDT relays, one solid state relay
DN125 to DN200 (5 in. to 8 in.) PVDF and Titanium. Two SPDT relays, one solid state relay

DN125 to DN200 (5 in. to 8 in.) PVDF and Hastelloy-C. Two SPDT relays, one solid state relay
DN125 to DN200 (5 in. to 8 in.) Polypropylene and 316L SS

DN125 to DN200 (5 in. to 8 in.) PVDF and Titanium

DN125 to DN200 (5 in. to 8 in.) PVDF and Hastelloy-C

DN250 to DN900 (10 in. to 36 in.) Polypropylene and 316L SS. Two SPDT relays, one solid state relay
DN250 to DN900 (10 in. to 36 in.) PVDF and Titanium. Two SPDT relays, one solid state relay
DN250 to DN900 (10 in. to 36 in.) PVDF and Hastelloy-C. Two SPDT relays, one solid state relay
DN250 to DN900 (10 in. to 36 in.) Polypropylene and 316L SS

DN250 to DN900 (10 in. to 36 in.) PVDF and Titanium

DN250 to DN900 (10 in. to 36 in.) PVDF and Hastelloy-C

Description
DN15 to DN100
DN15 to DN100
DN15 to DN100 (%2 in. to 4 in.
DN15 to DN100 (Y2 in. to 4 in.
DN15 to DN100 (%2 in. to 4 in.
DN15 to DN100 (%2 in. to 4 in.
DN125 to DN200 (5 in.
DN125 to DN200 (5 in.
DN125 to DN200 (5 in.
DN125 to DN200 (5 in.
DN125 to DN200 (5 in.

(

(

(

Y2 in.to 4 in.
Y2 in.to 4 in.

Polypropylene and 316L SS. Two SPDT relays, one solid state relay
PVDF and Titanium. Two SPDT relays, one solid state relay

PVDF and Hastelloy-C. Two SPDT relays, one solid state relay
Polypropylene and 316L SS.

PVDF and Titanium

PVDF and Hastelloy-C

to 8 in.) Polypropylene and 316L SS. Two SPDT relays, one solid state relay
to 8 in.) PVDF and Titanium. Two SPDT relays, one solid state relay

to 8 in.) PVDF and Hastelloy-C. Two SPDT relays, one solid state relay

to 8 in.) Polypropylene and 316L SS

to 8 in.) PVDF and Titanium

to 8 in.) PVDF and Hastelloy-C

10 in. to 36 in.) Polypropylene and 316L SS. Two SPDT relays, one solid state relay

—~ o~~~
e e e

DN125 to DN200 (5 in.
DN250 to DN900
DN250 to DN900 (10 in. to 36 in.) PVDF and Titanium. Two SPDT relays, one solid state relay

DN250 to DN900 (10 in. to 36 in.) PVDF and Hastelloy-C. Two SPDT relays, one solid state relay
DN250 to DN900 (10 in. to 36 in.) Polypropylene and 316L SS
DN250 to DN900 (10 in. to 36 in.) PVDF and Titanium
DN250 to DN900 (10 in. to 36 in.) PVDF and Hastelloy-C

Replacement Parts and Accessories

1220-0021
1224-0021
1228-0021
3-8050.390-1
3-8050.390-3
3-8050.390-4
3-8050.396
3-8551.521

198 801 000
198 820 006
198 820 007
159 001 702
159 310 116
159 310 117
159 000 617
159 001 378

O-ring, FKM

O-ring, EPDM

O-ring, FFKM

Retaining Nut Replacement Kit, NPT, Valox®
Retaining Nut Replacement Kit, NPT, PP
Retaining Nut Replacement Kit, NPT, PVDF
RC Filter kit (for relay protection)

Clear plastic cap for display
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